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SYNOPSys

CHAPTER 1

Getting Started

The Identify® Microsemi Edition tool set includes the Identify instrumentor
and the Identify debugger. These two tools allow you to debug your HDL
design:

e in the target system
e at the target speed
* at the VHDL/Verilog RTL source level

The Identify tool set helps you debug any design that is implemented by an
electronically programmable logic device such as an FPGA or PLD. For the
first time you will be able to debug live hardware with the internal design
visibility you need while using intuitive debugging techniques.

This guide provides comprehensive information about how the Identify tool
set works within your HDL design flow.

This chapter contains:
¢ Manual Conventions

¢ Tool Conventions

Identify Microsemi Edition User Guide © 2015 Synopsys, Inc.
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Getting Started Manual Conventions

Manual Conventions

There are several conventions that this manual uses in order to communicate
command information.

Text Conventions

There are several text conventions that this manual uses to organize
command, path, and directory information. These conventions or text styles

are:
This convention... Organizes this information...
BOId command titles

Monospacing type command, path name, and directory examples
Sans-serif type commands, literals, and keywords

Italics variable arguments

Syntax Conventions

There are several conventions that this manual uses to convey command
syntax. These conventions are:

This convention... Organizes this information...

bold Commands and literal arguments entered as shown.

italics User-defined arguments or example command
information.

[] Optional information or arguments for command
use. Do not include these brackets with the
command within the command line.

© 2015 Synopsys, Inc. Identify Microsemi Edition User Guide
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Tool Conventions Getting Started

This convention... Organizes this information...
Items that can be repeated any number of times.

Choices you can make between two items or
commands. The items are located on either side of
this symbol.

# Comments concerning the code or information
within the command line.

Tool Conventions

There are tool concepts you must familiarize yourself with when using the
Identify tool set. These concepts help you to decipher structural and
HDL-related information.

File System Conventions

The term file system refers to any command that uses file, directory, or path
name information in its argument. A file system reference must follow these
conventions:

Path Separator “/”

All file system commands that contain a directory name use only forward
slashes, regardless of the underlying operating system:

/usr/syn/data.dat

c:/synopsys/data.dat

Identify Microsemi Edition User Guide © 2015 Synopsys, Inc.
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Getting Started Tool Conventions

Wildcards

A wildcard is a command element you can use to represent many different
files. You can use these wildcards as arguments to the file system commands.
Conventions for wildcards are as follows:

Syntax Description

Matches any sequence of characters

? Matches any single character

Square brackets are used in pattern matching as follows:

Syntax Description
[abcd] Matches any character in the specified set.
[a-d] Matches any character in a specified range.

To use square brackets in wildcard specifications, you must delimit the entire
name with curly braces {}. For example,

{la-a]1}

matches any character in the specified range (a-d) preceding the character 1.

Design Hierarchy Conventions

Design hierarchy refers to the structure of your design. Design hierarchy
conventions define a way to refer to objects within the design hierarchy.

The Identify tool set supports both VHDL and Verilog. These languages vary
in their hierarchy conventions. The VHDL and Verilog languages contain
design units and hierarchies of these design units. In VHDL these design
units are entity/architecture pairs, in Verilog they are modules. VHDL and
Verilog design units are organized hierarchically. Each of the following HDL
design units creates a new level in the hierarchy.

© 2015 Synopsys, Inc. Identify Microsemi Edition User Guide
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Tool Conventions

Getting Started

VHDL

Veril

Desi

The top-level entity

Architectures

Component instantiation statements
Process statements

Control flow statements: if-then-else, and case
Subprogram statements

Block statements

og

The top-level module

Module instantiation statements

Always statements

Control flow statements: if-then-else, and case

Functions and tasks

gn Hierarchy References

A reference to an element in the design hierarchy consists of a path made up
of references to design units (similar to a file reference described earlier).
Regardless of the underlying HDL (VHDL or Verilog), the path separator
character is always “/”:

/inst/reset n

Absolute path names begin with a path separator character. The top-level
design unit is represented by the initial “/”. Thus, a port on the top-level
design unit is represented as:

/port_name

The architecture of the top-level VHDL design unit is represented as:

/arch

Identify Microsemi Edition User Guide
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Getting Started Tool Conventions

Relative path names do not start with the path separator, and are relative to
the current location in the design hierarchy. Initially, the current location is
the top-level design unit, but commands exist that allow you to change this

location.

Note: Design unit references can be case sensitive depending on the
HDL language. VHDL names are not case sensitive. In contrast,
Verilog names are case sensitive.

Wildcards

A wildcard is a command element you use to represent many different design
hierarchy references. You can use wildcard design references as arguments
to the design hierarchy commands. Conventions for wildcards are as follows:

Syntax Description

*

Matches any sequence of characters

? Matches any single character

Square brackets are used in hierarchy pattern matching as follows:

Syntax Description
[abcd] Matches any character in the specified set.
[a-d] Matches any character in a specified range.

To use square brackets in pattern matching, you must delimit the entire
name with curly braces {}. For example,

{[a-d]1}

matches any character in the specified range (a-d) preceding the character 1.

© 2015 Synopsys, Inc. Identify Microsemi Edition User Guide
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SYNOPSys

CHAPTER 2

System Overview

The Identify Microsemi Edition tool set is part of an HDL design flow process.
The tool set is a dual-component system that allows you to probe your HDL
design in the target environment. The system fits easily into your existing
design flow, with only a few modifications.

The dual-component system consists of the Identify instrumentor software
that allows you to select your design instrumentation at the HDL level and
then create an on-chip hardware probe, and the Identify debugger software
that interacts with the on-chip hardware probe and allows you to perform live
debugging of your design. A combined system of instrumentor and debugger
allows you to debug your design faster, easier, and more efficiently.

This chapter provides a high-level description of the Identify tool set, detailing
how the instrumentor and debugger work and how they fit into your design
flow. The chapter describes:

¢ The Debugging System
* The Design Flow

¢ System Components

Identify Microsemi Edition User Guide © 2015 Synopsys, Inc.
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System Overview The Debugging System

The Debugging System

The Identify tool set is based on the principle of in-system debugging. Using
these tools allows you to debug your device in the target system, at target
speed while debugging at the HDL level.

Starting with an HDL design, the Identify instrumentor enables you to create
a debuggable HDL version of your design. Then, the Identify debugger
communicates with this debuggable design, captures the operation of the
design, and relates the captured data back to the original HDL design.

The Identify tool set captures the device operation by inserting an IICE™
(Intelligent In-Circuit-Emulator) device into your design. The IICE is

connected to signals of interest in your design and communicates with a host
computer through a JTAG cable.

© 2015 Synopsys, Inc. Identify Microsemi Edition User Guide
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The Design Flow System Overview

The Design Flow

Design flows for HDL design and debugging vary according the type of
hardware and device you use. Displayed below is the typical HDL design flow
for a programmable hardware device and the design flow with the Identify tool

set:

Write HDL
Write HDL Instrument
Synthesis Synthesis

Place Place

and and
Route Roijte
Program Program
Device Device

Design Flow without ¢
Identify Tool set Debug

Design Flow with
Identify Tool Set

In the typical design flow, the first step is to create the HDL design files which
are then synthesized to the target device. Following synthesis, the design is
placed and routed, targeting a particular device. Then, the design is imple-
mented on the actual hardware by programming the device.

Identify Microsemi Edition User Guide © 2015 Synopsys, Inc.
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System Overview The Design Flow

The flow through the Identify tool set makes a very minor change to the
typical flow. After the HDL is successfully created, the Identify instrumentor
is used to create a debuggable HDL design. This design is then run through
the rest of the typical process. After the device is programmed with the
debuggable design, the Identify debugger is used to debug the design while it
is running in the target system.

Because the Identify tool set provides logic debugging capabilities in the
target system which is running at the target speed, the need for extensive
system-level simulation can be reduced. Instead, the effort in the simulation
step can concentrate on the much simpler and faster module-level simulation
and some system-level simulation. The Identify debugger is used to help
debug system-level functionality.

© 2015 Synopsys, Inc. Identify Microsemi Edition User Guide
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System Components

System Overview

System Components

The Identify system is made up of the following:

e IICE
* Identify Instrumentor

* Identify Debugger

IICE

The Intelligent In Circuit Emulator (IICE) is a custom block that is inserted
into your design and connected to signals in the design by the Identify instru-
mentor in accordance with your interface specifications. The IICE samples
internal signals and feeds the sampled signal information back to the Identify
debugger where the data is transformed for interpretation at the HDL level.

Identify Debugger

cPUl] Memory H £ [E
[ [ E

Bus —
Controller Large E

Data| E

Path| E

The IICE block is actually made up of two different types of blocks. The first is
the controller block and the second is the probe block. The probe block
samples internal signal data and communicates with the controller block.
The controller block communicates with the JTAG port.

Identify Microsemi Edition User Guide
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System Overview System Components

The probe block contains the sample buffer where signal value data is stored.
The probe block also contains the trigger logic that determines when the
signal data is stored in the sample buffer.

The controller block receives the sample data from the probe block and sends
it through the JTAG port to the Identify debugger.

Identify Instrumentor

The Identify instrumentor reads and analyzes the pre-synthesis HDL design
and provides detailed information about the signals that can be observed and
allows you to specify how to control signal observation.

The Identify instrumentor uses the HDL design files and the user-selection
information to create the custom IICE block. The Identify instrumentor
connects the IICE to the appropriate signals in the design and writes the new
design to a user-specified location.

Identify Debugger

The Identify debugger lets you interact with the debuggable hardware at the
HDL level. In the Identify debugger, you can activate breakpoints, set watch-
points, and view captured data related to the original source code or as
waveforms. In the Identify debugger, you set trigger conditions that determine
when to capture signal data. A trigger condition is a set of on-chip signal
values or events. When a trigger condition occurs, data is transferred from
the hardware device to the Identify debugger through the JTAG communica-
tion cable.

© 2015 Synopsys, Inc. Identify Microsemi Edition User Guide
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Innova

CHAPTER 3

Project Handling

A project contains all of the information required to instrument and debug a
design. This information includes references to the HDL design files, the
user-selected instrumentation, the settings used to create the IICE, the
watchpoint and breakpoint activations from the debugger, and other system
settings. Additionally, you can save the original design, in either an encrypted
or non-encrypted format, in a project subdirectory. The project file is used to
reproduce the exact state of the project in the Identify tool set.

This chapter describes the procedures for managing projects and includes:
* Projects in the Identify Instrumentor

* Identify Debugger Projects

Identify Microsemi Edition User Guide © 2015 Synopsys, Inc.
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Project Handling Projects in the Identify Instrumentor

Projects in the Identify Instrumentor

This section describes how projects are defined between the Identify instru-
mentor and the synthesis tool.

¢ Integrated — an Identify implementation is defined in the Synplify Pro
project and the Identify instrumentor is then launched directly from the
Identify implementation in that project.

* Assisted — an Identify implementation is defined in the Synplify Pro
project, the project is saved, and the synthesis tool exited. The Identify
instrumentor is then launched independently to open the saved project
file.

Integrated ldentify Instrumentor Projects

For Synplify Pro users, a Synopsys FPGA synthesis project (prj) file is
ﬁ passed to the Identify instrumentor to define the project. This project

file specifies the design files and their order, the device technology,
and the design’s top-level module or entity.

To make a Synplify Pro project available to the Identify instrumentor, open
the project in the corresponding Synplify Pro Project view and:

1. Right click on the implementation and select New Identify Implementation
from the popup menu.

2. Set/verify any technology, device mapping, or other pertinent options
(see the implementation option descriptions in the Synopsys FPGA
Synthesis User Guide) and click OK. A new, Identify implementation is
added to the project view.

© 2015 Synopsys, Inc. Identify Microsemi Edition User Guide
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Projects in the Identify Instrumentor Project Handling

'Synplify Pro®

2Run
| Ready

Project Files Design Hierarchy |
|Microsemi SmartFusion2 : M25050T : FBGAS96 : 5TD
E- & [proj_m1] - C:\designs'bus_demo_2012\proj_m1.prj

| ':r Open Praject... |
[ Add File... || =@ o

| B Close Project

rev_1
|li=§ Change File... rev 2

|§_¥. Add Implementation...

\ Identify

Implementation

|{:@' Implementation Options. ..

3. Either right click on the Identify implementation and select Launch Identify
Instrumentor from the popup menu or click the Launch Identify Instrumentor
toolbar icon to launch the Identify instrumentor.

Note: If you are prompted to locate the executable, enter the path to the
Identify software in the Locate Identify Installation field (use the
browse button to the right of the field). Similarly, if you are
prompted to select a license type, select the appropriate type
from the list; check the Save as default license type box to avoid the
license prompt in future sessions.

Launching the Identify instrumentor from the Synplify Pro synthesis tool:
* Brings up the Identify instrumentor graphical interface.

* Extracts the list of design files, their work directories, and the device
family from the project (prj) file.

e Automatically compiles the design files using the synthesis tool compiler
and displays the design hierarchy and the HDL file content with all the
potential instrumentation marked and available for selection.

Identify Microsemi Edition User Guide © 2015 Synopsys, Inc.
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Project Handling Projects in the Identify Instrumentor

Assisted Identify Instrumentor Projects

—~g A Synplify Pro project with an existing Identify implementation can
li, be opened directly in the Identify instrumentor. To open a synthesis
project directly from the Identify instrumentor, select File->Open project
from the main menu, click the Open existing project icon, or click the
Open Project button in the project window. Each of these commands brings up
the Open Project file dialog box to allow you to navigate to the directory
containing the Synplify Pro project (prj) files.

On opening a Synplify Pro project file, the data for that project is loaded into
the Identify instrumentor. Loading a project retrieves all of the information
stored in the project (user settings and file histories are automatically saved).
The Identify instrumentor automatically compiles the files. When compilation
is complete, the instrumentation window displays the design hierarchy and
the HDL file content with all the potential instrumentation marked and avail-
able for selection.

A list of the four, most recent projects is maintained by the Identify instru-
mentor. Any of these projects can be opened directly from the File->Recent
Projects menu.

Viewing a Compiled File

Once a design has been successfully compiled, the contents of individual
HDL files can be opened in the currently active IICE. To open an HDL file,
either double click on the filename or icon in the project view or right click on
the filename or icon and select View file from the popup menu. The selected file
is displayed in the currently active IICE display.

Open Project... | =] i@ verplex_design ;I
B whdl
const_pkg.vhd [wark]
MHew lICE | data_mux.vhd [:,.-.,u::[

ing_decode vhd [w
inz_rom.vhd [comps]
io.vhd [work]
po.vhd [work]
req_file.vhd [wark]
zpol_regz.vhd [work]
alu.vhd [wark]

© 2015 Synopsys, Inc. Identify Microsemi Edition User Guide
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Projects in the Identify Instrumentor Project Handling

Technology Cell Definitions

The Identify instrumentor normally instantiates module definitions for
technology-specific cells. When a technology cell is not previously defined, the
Identify instrumentor creates a dummy (empty) black box for the undefined
module to allow the compilation to complete.

To disable the generation of black boxes for uninstantiated module defini-
tions, enter the following command in the Identify instrumentor console
window:

device technologydefinitions 0

Note: The command accepts all Boolean arguments (O, off, false, 1, on,
or true). Entering the command without an argument returns the
current setting.

Instrumenting and Saving a Project

After setting up the IICE as described in Chapter 4, IICE Configuration and
after selecting the instrumentation (selecting the signals for sampling, and
setting breakpoints) as described in Chapter 6, Identify Instrumentor, a
description of the instrumented project is saved.

tion from the menu or click on the Save project’s activated instrumentation

ﬁ To save your instrumented project, select File->Save project instrumenta-
icon.

Saving a project generates an instrumentation design constraints (idc) file and
adds compiler pragmas in the form of constraint files to the design RTL for
the instrumented signals and break points. This information is then used by
the Synplify Pro synthesis tool to incorporate the instrumentation logic (IICE
and COMM blocks) into the synthesized netlist.

Identify Microsemi Edition User Guide © 2015 Synopsys, Inc.
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Project Handling Identify Debugger Projects

|ldentify Debugger Projects

This section includes descriptions of the following tasks associated with the
Identify debugger:

¢ Opening an Identify Debugger Project
¢ Configuring an Identify Debugger Project

e Saving a Project

Opening an Identify Debugger Project

—~y To open a project in the Identify debugger, the project must have
li' been created in the Identify instrumentor (only the Identify instru-
mentor can create a project) and synthesized in the Synplify Pro
synthesis tool. To open an existing Identify debugger project from
the synthesis tool, highlight the Identify implementation and do one of the
following:

¢ select Launch Identify Debugger from the popup menu
¢ click the Launch Identify Debugger icon in the menu bar

¢ select Run->Launch Identify Debugger from the main menu

You can also open an existing project from the Identify debugger interface by
selecting File->Open Project from the menu or by clicking on the Open existing
project icon. The name of the project file will have a prj extension. A list of the
four, most recent projects is maintained by the Identify debugger. Any of
these projects can be opened directly from the File->Recent Projects menu. On
opening, the data for the project is loaded into the Identify debugger. Loading
a project retrieves all of the information stored in a project and makes that
project the current working project.

Configuring an Identify Debugger Project

To configure an Identify debugger project, click the project tab to reopen the
project window (reopening the project window shows the instrumentation
and communication settings).

© 2015 Synopsys, Inc. Identify Microsemi Edition User Guide
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Reviewing the Instrumentation Settings

The Instrumentation settings are displayed in the Instrumentation settings

section of the project window. Because these configuration settings are inher-

ited from the Identify instrumentor and used to construct the IICE, you
cannot change these settings in the Identify debugger.

Changing the Communication Settings

The cable type and port specification communication settings can be set or

changed from the debugger project window. The available settings for

Microsemi are Microsemi_BuiltindTAG which works for all supported technolo-
gies and demo (the demo setting is used when there is no physical Microsemi

device connected).

Adjust the port setting based on the port where the communication cable is

connected. Most often, Ipt1 is the correct setting for parallel ports.

B
Sample Mode: | normal ¥ || Cross trigger mode: | dizabled hd @

Communication settings

Cable type: [Microsemi_Builtin TAG |~

W IICE Part settings .. | Show chain ... |

¥ NCE_D Comm check. ...

Inztrumentation settings

Drevice family: igloopluz
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Reviewing the JTAG Chain Settings

The JTAG chain settings are viewed by clicking the Show chain button in the
Communication settings section of the project window. Normally, the JTAG chain
settings for the devices are automatically extracted from the design. When the
chain settings cannot be determined, they must be created and/or edited
using the chain command in the console window. The settings shown below
are for a 2-device chain that has JTAG identification register lengths of 8 and
10 bits. In addition, the device named “fpga” has been enabled for debugging.

Debug: Device ID:
[1 prom
[x=] foga

Auto-detect

“fpga” device enabled for debugging

Saving a Project

Saving a project in the Identify debugger saves the following additional
project information to the project file:

e JICE settings

¢ Instrumentations and activations

To save a project in the Identify debugger, click the Save current activa-
H tions icon or select File->Save activations from the menu.
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CHAPTER 4

lICE Configuration

An important part of the configuration of a project is setting the parameters
for the Intelligent In-Circuit Emulator (IICE) in the Identify instrumentor. The
IICE parameters determine the implementation of one or more IICE units and
configure the units so that proper communication can be established with
the Identify debugger. The IICE parameters common to all IICE units are set
in the Identify instrumentor project window and apply to all IICE units
defined for the implementation; the [ICE parameters unique to each IICE
definition in a multi-IICE configuration are interactively set on one of two IICE
Configuration dialog box tabs:

* |ICE Sampler Tab — includes sample depth selection and clock specification.

* |ICE Controller Tab — includes complex counter trigger width specification,
selection of state machine triggering, and import/export of the IICE trigger
signal.

This chapter describes how to configure one or more IICE units.
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Multiple lICE Units

Multiple IICE units allow triggering and sampling of signals from different clock
domains within a design. Each IICE unit is independent and can have unique
IICE parameter settings including sample depth, sampling/triggering options,
and sample clock and clock edge. During the debugging phase, individual or
multiple IICE units can be armed.

Adding an lICE Unit

A New IICE button is included in the Identify instrumentor project window to
allow an additional IICE to be defined for the current instrumentation. When
you click the New IICE button, the project window is reduced to a tab and a
new instrumentation window is opened with the HDL source code redis-
played without any signals instrumented.

Note: When you create a new IICE from the GUI, the name of the IICE
unit is formed by adding an _n suffix to IICE (for example,
IICE_O, IICE_1, etc.). If you create a new IICE from the command
line using the Identify instrumentor iice new command, you can
optionally include a name for the IICE.

Right-clicking on the IICE tab and selecting Configure [ICE from the popup
menu brings up the Configure IICE dialog box which allows you to define the
parameters unique to the selected IICE (see Individual IICE Parameters, on
page 33).

Note: Communication port selection, which is common to all IICE units
for an instrumentation, is defined in the Identify instrumentor
project window (see Common IICE Parameters, on page 31).

Deleting an IICE Unit

To delete an IICE unit from your Identify instrumentor project, right-click on
the tab of the IICE to be deleted and select Delete IICE from the popup menu.
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Common IICE Parameters

The IICE parameters common to all IICE units defined for an instrumentation
include:

e the IICE device family as defined by the synthesis tool
* the communication port

* if optional skew-resistant hardware is to be used

These parameters are set/displayed in the project window for the currently-
active instrumentation. All IICE units in a multi-IICE configuration share
these same parameter values.

Instrumentation Options for rey_4'

Drevwice family: igloopluz

Cormmunication part: buiiltir j

I Use skew resistant hardware

Device Family

The device family selected in the synthesis tool is reported in the Device family
field (the field is read-only) and cannot be changed.

Note: If the device family specified in the synthesis tool is not
supported by the Identify tool set, an error message is issued and
you are prompted to exit the Identify instrumentor.

Communication Port

The Communication port parameter specifies the type of connection to be used to
communicate with the on-chip IICE. The connection types are:

e builtin — indicates that the IICE is connected to the JTAG Tap controller
available on the target device.
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¢ soft— indicates that the Synopsys Tap controller is to be used. The
Synopsys FPGA Tap controller is more costly in terms of resources
because it is implemented in user logic and requires four user I/O pins
to connect to the communication cable.

See Chapter 9, Connecting to the Target System, for a description of the
communication interface.

Use Skew-Resistant Hardware

The Use skew-resistant hardware check box, when checked, incorporates skew-
resistant master/slave hardware to allow the instrumentation logic to operate
without requiring an additional global clock buffer resource for the JTAG
clock.

When no global clock resources are available for the JTAG clock, this option
causes the IICE to be built using skew-resistant hardware consisting of
master-slave flip-flops on the JTAG chain which prevents clock skew from
affecting the logic. Enabling this option also causes the Identify instrumentor
to NOT explicitly define the JTAG clock as requiring global clock resources.
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Individual IICE Parameters

the Configure IICE dialog box. To display this dialog box, first select the

active IICE by clicking the appropriate IICE tab in the Identify instru-

mentor project window and then select Actions->Configure IICE from the
menu or click on the Edit ICE settings icon. You can also right-click directly on
the IICE tab and select Configure IICE from the popup menu.

: The individual parameters for each IICE are defined on two tabs of

21 component REG FILE

J 22 port
L« o L

w_@mi | GTAICE_0 | (TANCE_1 |

IICE tabs

IICE Sampler Tab

The IICE Sampler tab defines:
e IICE unit for multi-IICE configurations
* IICE type (regular)
* Bulffer type (internal_memory)
e Sample depth
* Sampling/triggering options
* Data compression use

e Sample clock and clock edge

Identify Microsemi Edition User Guide © 2015 Synopsys, Inc.
March 2015 33



IICE Configuration Individual IICE Parameters

IICE Sarmpler
Current IICE: | IICE j IICE type:  |regular
IICE Sampler
Buffer tupe: | internal_memony j
Sample depth | 2048 =

I Allow qualified sampling

I~ Allow abways-armed tiggering

I~ Allow data compression

Sample Clock

Sample clock: /behdarb_inztdclk

Clock edge: * Positive © Negative

Current lICE

The Current lICE field identifies the target IICE when there are multiple IICE
units defined within an implementation. The IICE is selected from the drop-
down menu.

lICE type

The IICE type parameter is a read-only field that specifies the type of IICE
unit currently selected. The only available setting is regular.

Buffer Type

The Buffer type parameter specifies the type of RAM to be used to capture the
on-chip signal data. The only available setting is internal_memory.

Sample Depth

The Sample depth parameter specifies the amount of data captured for each
sampled signal. Sample depth is limited by the capacity of the FPGAs imple-
menting the design, but must be at least 8 due to the pipelined architecture
of the IICE.
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Sample depth can be maximized by taking into account the amount of RAM
available on the FPGA. As an example, if only a small amount of block RAM is
used in the design, then a large amount of signal data can be captured into
block RAM. If most of the block RAM is used for the design, then only a small
amount is available to be used for signal data. In this case, it may be more
advantageous to use logic RAM.

Allow Qualified Sampling

The Allow qualified sampling check box, when checked, causes the Identify
instrumentor to build an IICE block that is capable or performing qualified
sampling. When qualified sampling is enabled, one data value is sampled
each time the trigger condition is true. With qualified sampling, you can
follow the operation of the design over a longer period of time (for example,
you can observe the addresses in a number of bus cycles by sampling only
one value for each bus cycle instead of a full trace). Using qualified sampling
includes a minimal area and clock-speed penalty.

Allow Always-Armed Triggering

The Allow always-armed triggering check box, when checked, saves the sample
buffer for the most recent trigger and waits for the next trigger or until inter-
rupted. When always-armed sampling is enabled, a snapshot is taken each
time the trigger condition becomes true.

With always-armed triggering, you always acquire the data associated with
the last trigger condition prior to the interrupt. This mode is helpful when
analyzing a design that uses a repeated pattern as a trigger (for example, bus
cycles) and then randomly freezes. You can retrieve the data corresponding to
the last time the repeated pattern occurred prior to freezing. Using always-
armed sampling includes a minimal area and clock-speed penalty.

Allow data compression

The Allow data compression check box, when checked, adds compression logic to
the IICE to support sample data compression in the Identify debugger (see
Sampled Data Compression, on page 95). When unchecked (the default),
compression logic is excluded from the IICE, and data compression in the
Identify debugger is unavailable. Note that there is a logic data overhead
associated with data compression and that the check box should be left
unchecked when sample data compression is not to be used.
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Sample Clock

The Sample clock parameter determines when signal data is captured by the
IICE. The sample clock can be any signal in the design that is a single-bit
scalar type. Enter the complete hierarchical path of the signal as the param-
eter value.

Care must be taken when selecting a sample clock because signals are
sampled on an edge of the clock. For the sample values to be valid, the
signals being sampled must be stable when the specified edge of the sample
clock occurs. Usually, the sample clock is either the same clock that the
sampled signals are synchronous with or a multiple of that clock. The sample
clock must use a scalar, global clock resource of the chip and should be the
highest clock frequency available in the design. The source of the clock must
be a buffered output from the global clock resource.

L DCM/PLL X— _G

Buffer

You can also select the sample clock from the instrumentation window by
right-clicking on the watchpoint icon in the source code display and selecting
Sample Clock from the popup menu. The icon for the selected (single-bit) signal
changes to a clock face as shown in the following figure.

B

5L alwayz @ pozedge G l or negedge &oclr)

LR begin

57 if (#dfclr == 1'b0)

58 dgcurrent =tate = = RESET: -+ 4'b0000 * Sample Clock
g9 else begin Icon

Note: You must set the other individual IICE parameters from the
Configure IICE dialog box including the sample clock edge.
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Clock Edge

The Clock edge radio buttons determine if samples are taken on the rising
(positive) or falling (negative) edge of the sample clock. The default is the
positive edge.

IICE Controller Tab

The IICE Controller tab selects the IICE controller’s triggering mode. All of these
instrumentation choices have a corresponding effect on the area cost of the
Identify IICE.

IICE Contraller

Current [ICE:  |IICE j IICE type:  |regular
IICE Contraller
" Simple tiggering

* Complex counter tiggering

Width: [16 2
" State Machine tiggering
Trigaer states: |4 ﬁ
Trigger conditions: |4 j‘
Counter width: |1E ﬁ
IICE Options
Import external trigger signals: |D ﬂ

[~ Export ICE trigger signal

[T &llows crozs-tiggenng in 1ICE

Current lICE

The Current lICE field is used to identify the target IICE when there are multiple
IICE units defined within an implementation. The IICE is selected from the
drop-down menu.

Identify Microsemi Edition User Guide © 2015 Synopsys, Inc.
March 2015 37



IICE Configuration Individual IICE Parameters

lICE type

The IICE type parameter is a read-only field that specifies the type of IICE
unit currently selected. The only available setting is regular.

Simple Triggering

Simple triggering allows you to combine breakpoints and watchpoints to
create a trigger condition for capturing the sample data.

Complex-Counter Triggering

Complex-counter triggering augments the simple triggering by instrumenting
a variable-width counter that can be used to create a more complex trigger
function. Use the width setting to control the desired width of the counter.

State-Machine Triggering

State-machine triggering allows you to pre-instrument a variable-sized state
machine that can be used to specify an ultimately flexible trigger condition.
Use Trigger states to customize how many states are available in the state
machine. Use Trigger condition to control how many independent trigger condi-
tions can be defined in the state machine. For more information on state-
machine triggering, see State Machine Triggering, on page 120.

Import External Trigger Signals

External triggering allows the trigger from an external source to be imported
and configured as a trigger condition for the active IICE. The external source
can be a second IICE located on a different device or external logic on the
board rather than the result of an Identify instrumentation. The imported
trigger signal includes the same triggering capabilities as the internal trigger
sources used with state machines. The adjacent field selects the number of
external trigger sources with O, the default, disabling recognition of any
external trigger. Selecting one or more external triggers automatically enables
state-machine triggering.

Note: When using external triggers, the pin assignments for the corre-
sponding input ports must be defined in the synthesis or place
and route tool.
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Export IICE Trigger Signal

The Export IICE trigger signal check box, when checked, causes the master
trigger signal of the IICE hardware to be exported to the top-level of the
instrumented design.

Allow cross-triggering in IICE

The Allow cross-triggering in lICE check box, when checked, allows this I[ICE unit
to accept a cross-trigger from another IICE unit. For more information on
cross-triggering, see Cross Triggering, on page 104.
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CHAPTER §

Support for Instrumenting HDL

The Identify tool set fully supports the synthesizable subset of both Verilog
and VHDL design languages. Designs that contain a mixture of VHDL and
Verilog can be debugged — the Identify software reads in your design files in
either language.

There are some limitations on which parts of a design can be instrumented
by the Identify instrumentor. However, in all cases you can always instru-
ment all other parts of your design.

The instrumentation limitations are usually related to language features.
These limitations are described in this chapter.

e VHDL Instrumentation Limitations, on page 42
* Verilog Instrumentation Limitations, on page 44

e SystemVerilog Instrumentation Limitations, on page 47
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VHDL Instrumentation Limitations

The synthesizable subsets of VHDL IIEEE 1076-1993 and IEEE 1076-1987
are supported in the current release of the Identify debugger.

Design Hierarchy

Entities that are instantiated more than once are supported for instrumenta-
tion with the exception that signals that have type characteristics specified by
unique generic parameters cannot be instrumented.

Subprograms

Subprograms such as VHDL procedures and functions cannot be instru-
mented. Signals and breakpoints within these specific subprograms cannot
be selected for instrumentation.

Loops

Breakpoints within loops cannot be instrumented.

Generics

VHDL generic parameters are fully supported as long as the generic param-
eter values for the entire design are identical during both instrumentation
and synthesis.

Transient Variables

Transient variables defined locally in VHDL processes cannot be instru-
mented.

Post-Compile Instrumentation

Post-compile instrumentation allows signals to be instrumented directly in
the post-compiled netlist which can eliminate some of the limitations with
VHDL instrumentation. For more information, see Instrumenting Signals
Directly in the idc File, on page 68.
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Breakpoints and Flip-flop Inferencing

Breakpoints inside flip-flop inferring processes can only be instrumented if
they follow the coding styles outlined below:

For flip-flops with asynchronous reset:

process (clk, reset, ...) begin
if reset = '0' then
reset statements;
elsif clk’event and clk = 'l' then
synchronous_assignments;
end if;
end process;

For flip-flops with synchronous reset or without reset:

process (clk, ...) begin
if clk’event and clk = '1l' then
synchronous_assignments;
end if;
end process;

process begin
wait until clk’event and clk = '1'
synchronous_assignments;
end process;

The reset polarity and clock-edge specifications above are only exemplary.
The Identify software has no restrictions with respect to the polarity of reset
and clock. A coding style that uses wait statements must have only one wait
statement and it must be at the top of the process.

Using any other coding style for flip-flop inferring processes will have the
effect that no breakpoints can be instrumented inside the corresponding
process. During design compilation, the Identify instrumentor issues a
warning when the code cannot be instrumented.
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Verilog Instrumentation Limitations

The synthesizable subsets of Verilog HDL IEEE 1364-1995 and 1364-2001
are supported.

Subprograms

Subprograms such as Verilog functions and tasks cannot be instrumented.
Signals and breakpoints within these specific subprograms cannot be
selected for instrumentation.

Loops

Breakpoints within loops cannot be instrumented.

Parameters

Verilog HDL parameters are fully supported. However, the values of all the
parameters throughout the entire design must be identical during instru-
mentation and synthesis.

Locally Declared Registers

Registers declared locally inside a named begin block cannot be instrumented
and will not be offered for instrumentation. Only registers declared in the
module scope and wires can be instrumented.

Verilog Include Files

There are no limitations on the instrumentation of 'include files that are refer-
enced only once. When an 'include file is referenced multiple times as shown in
the following example, the following limitations apply:

e If the keyword module or endmodule, or if the closing ‘)’ of the module port
list is located inside a multiply-included file, no constructs inside the
corresponding module or its submodules can be instrumented.

* If significant portions of the body of an always block are located inside a
multiply-included file, no breakpoints inside the corresponding always
block can be instrumented.
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If either situation is detected during design compilation, the Identify instru-
mentor issues an appropriate warning message.

As an example, consider the following three files:

adder.v File

module adder (cout,
parameter size = 1;
output cout;
output [size-1:0]
input cin;

sum, a, b,

sum;

cin) ;

input [size-1:0] a, b;
assign {cout, sum} = a + b + cin;
endmodule

adder8.v File

“include "adder.v"
module adder8 (cout,
output cout;
parameter my size = 8;
output [my size - 1: 0] sum;
input [my size - 1: 0] a, b;
input cin;

sum, a, b,

adder #(my size) my adder (cout, sum, a, b,

endmodule

adder16.v File

“include "adder.v"
module adderlé (cout,
output cout;
parameter my size = 16;
output [my size - 1: 0] sum;
input [my size - 1: 0] a, b;
input cin;

sum, a, b,

adder #(my size) my adder (cout, sum, a, b,

endmodule

cin) ;

cin) ;

cin) ;

cin) ;

There is a workaround for this problem. Make a copy of the include file and
change one particular include statement to refer to the copy. Signals and
breakpoints that originate from the copied include file can now be instru-

mented.
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Macro Definitions

The code inside macro definitions cannot be instrumented. If a macro defini-
tion contains important parts of some instrumentable code, that code also
cannot be instrumented. For example, if a macro definition includes the case
keyword and the controlling expression of a case statement, the case state-
ment cannot be instrumented.

Always Blocks

Breakpoints inside a synchronous flip-flop inferring an always block can only
be instrumented if the always block follows the coding styles outlined below:

For flip-flops with asynchronous reset:

always @ (posedge clk or negedge reset) begin
if (!reset) begin
reset statements;
end
else begin
synchronous_assignments;
end;
end;

For flip-flops with synchronous reset or without reset:

always @(posedge clk) begin
synchronous_assignments;
end process;

The reset polarity and clock-edge specifications and the use of begin blocks
above are only exemplary. The Identify instrumentor has no restrictions with
respect to these other than required by the language.

For other coding styles, the Identify instrumentor issues a warning that the
code is not instrumentable.

Post-Compile Instrumentation

Post-compile instrumentation allows signals to be instrumented directly in
the post-compiled netlist which can eliminate some of the limitations with
Verilog instrumentation. For more information, see Instrumenting Signals
Directly in the idc File, on page 68.
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SystemVerilog Instrumentation Limitations

The synthesizable subsets of Verilog HDL IEEE 1364-2005 (SystemVerilog)
are supported with the following exceptions.

Typedefs

You can create your own names for type definitions that you use frequently in
your code. SystemVerilog adds the ability to define new net and variable user-
defined names for existing types using the typedef keyword. Only type defini-
tions of supported types are supported.

Struct Construct

A structure data type represents collections of data types. These data types
can be either standard data types (such as int, logic, or bit) or, they can be
user-defined types (using SystemVerilog typedef). Signals of type structure can
only be sampled and cannot be used for triggering; individual elements of a
structure cannot be instrumented, and it is only possible to instrument
(sample only) an entire structure. The following code segment illustrates
these limitations:

module 1lddt P _Struc top (
input @fsig clk, dofsig rst,

Cannot be instrumented
(no sampling and

output struct packed { ! C

logic_nibble up_nibble;% no triggering)
logic _nibble lo nibble;

} sig oport_P_struc_data ~—____| Instrumentable only for

sampling; no triggering

) ;

In the above code segment, port signal sig_oport_P_Struc_data is a packed
structure consisting of two elements (up_nibble and lo_nibble) which are of a
user-defined datatype. As elements of a structure, these elements cannot be
instrumented. The signal sig_oport P_Struc_data can be instrumented for
sampling, but cannot be used for triggering (setting a watch point on the
signal is not allowed). If this signal is instrumented for sample and trigger,
the Identify instrumentor allows only sampling and ignores triggering.
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Union Construct

A union is a collection of different data types similar to a structure with the
exception that members of the union share the same memory location.
Unions are not supported for instrumentation and it is not possible to select
a union datatype signal for either sampling or triggering. The following code
segment illustrates this limitation:

module 1ddt P Union top (
input #gsig eclk, do=zig rsto,
input union packed {
type P Struc datapkt P_Struc data;

logic [7:0][7:0] P Array data; Cannot be instrumented
} sigﬁiportipiUnionidata, (no Samp“ng and

output union packed { no triggering)
type P Struc datapkt P_Struc ta;

logic [7:0] [7:0] P_Array data;
} sig oport P Union data

) ;

In the above code, port signals sig_iport_P_Union_data and sig_oport_P_Union_data
are of type union. Code that includes union constructs compiles successfully
without error in the synthesis tool, but is disabled for instrumentation in the
Identify instrumentor.

Arrays

Arrays having more than one dimension cannot be instrumented for
triggering. The following code segment illustrates these limitation:

module test (clock,waddress,waddressl,
raddress,we,data,datal,q,ql) ;

input clock;

input [8:0] waddress,w

input we;

input [255:0] [31:0] data,

output reg [31:0] g, gl;

sl,raddress;

dat

Instrumented for sampling only

In the above code segment, waddress, waddress1, and raddress are one dimen-
sional packed arrays. These signals can be instrumented for both sampling
and triggering. Signals data and datal are 2-dimensional arrays. These signals
can only be instrumented for sampling, and triggering is not allowed.
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Partial instrumentation of multi-dimensional and multi-dimensional arrays
of struct is not permitted, and instrumentation of multi-dimensional arrays of
packed unions is not supported.

Interface

Interface and interface items are not supported for instrumentation and
cannot be used for sampling or triggering. The following code segment illus-
trates this limitation:

interface ff if (input logic clk, input logic rst,

input logic din, output logic dout) ;
modport write (input clk, input rst, input din, output dout) ;
endinterface: ff if

module top (input logic clk, input logic rst,
input logic din, output logic dout) ;

ff if £ff if top(.clk(clk), .rst(rst), .*);
sff UUT (.ff if O(ff if top.write));
endmodule

In the above code segment, the interface instantiation of interface ff_if is
ff_if top which cannot be instrumented. Similarly, interface item modport write
cannot be instrumented.

Port Connections for Interfaces and Variables

Instrumentation of named port connections on instantiations to implicitly
instantiate ports is not supported.

Packages

Packages permit the sharing of language-defined data types, typedef user-
defined types, parameters, constants, function definitions, and task defini-
tions among one or more compilation units, modules, or interfaces. Instru-
mentation within a package is not supported.

Concatenation Syntax

The concatenation syntax on an array watchpoint signal is not accepted by
the Identify debugger. To illustrate, consider a signal declared as:

bit [3:0] sig bit type;
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To set a watchpoint on this signal, the accepted syntax in the Identify
debugger is:

watch enable -iice IICE {/sig bit type} {4’'b1001}

The 4-bit vector cannot be divided into smaller vectors and concatenated (as
accepted in SystemVerilog). For example, the below syntax is not accepted:

watch enable -iice IICE {/sig bit type} {{2'b10,2'b01}}

Post-Compile Instrumentation

Post-compile instrumentation allows signals to be instrumented directly in
the post-compiled netlist which can eliminate some of the limitations with
SystemVerilog instrumentation. For more information, see Instrumenting
Signals Directly in the idc File, on page 68.
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CHAPTER 6

|dentify Instrumentor

The Identify instrumentor performs the following functions:
* defines the instrumentation for the user’s HDL design
* creates the instrumented HDL design
* creates the associated IICE

* creates the design database

The remainder of this chapter describes:
¢ Identify Instrumentor Windows

¢ Commands and Procedures

|dentify Instrumentor Windows

The Graphical User Interface (GUI) for the Identify instrumentor is divided
into the following three major areas:

¢ Instrumentation Window
¢ Project Window

¢ Console Window
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In this section, each of these areas and their uses is described. The following
discussions assume that a project (with an HDL design) has been loaded into
the Identify instrumentor.

Instrumentation Window

The instrumentation window includes a hierarchy browser on the left and the
source-code display on the right. The window is displayed when you open a
synthesis project (prj) file in the Identify instrumentor by either launching
the Identify instrumentor from a synthesis project or explicitly loading a
synthesis project into the Identify instrumentor.

P
€ Identify Instrumentaor - [C:/designs/micro_tut/bus_demo gm

File Edit Actions Options Help

S REEEE | B @ e

@ ROOT (bus_deme] J 0 entity bus demo is ﬂ
& beh E _
& ward_sfer_inst [wa 1 generic ( 1
& wiord_fer_chiel_in 2 data width : positive := 8;
& blk_sfer_inst [blocl -
& blk_sfer_cntdl_inst 3 addr width : positive := 10;

& arb_inst [arbiter)

o rom_ingt [wh_romj
o raml_inst [wh_ram
o ramZ_ingt [wh_ram

[
%

slave_ addr size: positive :
I
port |

o

T &dclk : in std logic:

Goadr o: out std logic vector (addr width-1

W W L W L W L W W W

o

fodat_o: out std_logic vector (data width-1h-1

: o L | B
@bus_demo E:EHCE I

Hierarchy Browser Source-Code Display

Hierarchy Browser

The hierarchy browser on the left shows a graphical representation of the
design’s hierarchy. At the top of the browser is the ROOT node. The ROOT
node represents the top-level entity or module of your design. For VHDL
designs, the first level below the ROOT is the architecture of the top-level
entity. The level below the top-level architecture for VHDL designs, or below
the ROOT for Verilog designs, shows the entities or modules instantiated at
the top level.
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Clicking on a + sign opens the entity/module instance so that the hierarchy
below that instance can be viewed. Lower levels of the browser represent
instantiations, case statements, if statements, functional operators, and other
statements.

o word_zfer_inzst [ward_xfer]
o word_sfer_chtl_ingt [word_sfer_cntrl]
& beh
o lFer_ingt (Ifer)
process_109
& process 137
‘ process 147

Single clicking on any element in the hierarchy browser causes the associ-
ated HDL code to be visible in the adjacent source code display.

A popup menu is available in the hierarchy browser to set or clear break-
points or watchpoints at any level of the hierarchy. Positioning the cursor
over an element and clicking the right mouse button displays the following
menu.

Wiew hierachy in Source Yiewer

[nztrument all breakpoints
Femove all inztrumented breakpaints

Instrument all signalz for S ampledT ngger
Instrument all zignalzs far Sample Oy
Ingtrument all signalzs far Trigger Only

Femove all inztrumented zignals

The selected operation is applied to all breakpoints or signal watchpoints at
the selected level of hierarchy.

Note: You cannot instrument signals when a sample clock is included
in the defined group.
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The popup menu functions can be duplicated in the console window using
the Identify instrumentor hierarchy command in combination with either the
Identify instrumentor breakpoints or signals command. A typical Identify instru-
mentor command sequence to instrument the signal set within a design
would be:

signals add [hierarchy find -type signal /]

In the above sequence, the slash (/) indicates that all of the signals in the root
hierarchy (entire design) are to be instrumented. If you specify a lower level of
hierarchy following the slash, the command only applies to that hierarchical
level. For more information on the Identify instrumentor breakpoints, signals,
and hierarchy commands, see the Reference Manual.

Black-box modules are represented by a black icon, and their contents can
not be instrumented. Also, certain modules cannot be instrumented (see
Chapter 5, Support for Instrumenting HDL, for a specific description). Modules
that cannot be instrumented are displayed in a disabled state in a grey font.

Source Code Display

The HDL source code in the source code display is annotated with signals
that can be probed and breakpoints that can be selected. Signals that can be
selected for probing by the IICE are underlined, colored in blue, and have
small watchpoint icons next to them. Source lines that can be selected as
breakpoints have small circular icons in the left margin adjacent to the line

number.
e begin
g7 if #gclr = '0' then
Ca docurrent state <= = RESET:
59 elsif fgclk'event and dfgclk = '1' then
E0 caze dofcurrent state is
4 [ when = RESET =» ddcurrent =tate <= = ONE:
4 B2 when = CHE =r ddcurrent =tate <= = TWQ;
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Project Window

The project window is displayed when you first start up the Identify instru-
mentor (to invoke the Identify instrumentor, see Projects in the Identify
Instrumentor, on page 22).

The project window includes a set of project management buttons and a
symbolic view of the project on the left and an area for setting the common
IICE parameters on the right (the area below the common IICE parameters
shows the top-level unit when the design was compiled).

(@ e ————
€ Identify Instrumentor - [Ci/designs/micro_tut/bus_demo gm
File Edit Actions Options Help
#4|G A
PrOjeCt - Open Project E_@ bus_demo® J Instrumentation Options for rev_2"
— | B vhd o
Buttons a arbuvhd [wark] Device family: |iglooplus
New IICE bik_xfer_crtd.vhd [work] . f —
Ll block_sfer.vhd [work] Communicatiorn, 2Mrt: |bU|It|n ﬂ
b4 bus_demo.vhd [work]
IFsr.vhd [work]

ram_impl.whd [work]

Project ram_irmpl.vhd [work] 36 skew resistant hardware
wh_ram.vhd [work]
Symbols wh_rorn.vhd [work] ™ Prepare incremental

wird_sfer.vhd [work]

] word_wfer_cntrl.vhd [wprfc] Compile Options

ey 2
JJ Top level unit; |work. bus_demo
Kl /
""" bus_derno® @”CE
Common’lICE Top-Level
Parameters Unit

The project window can be displayed at any time by clicking the project name
tab that remains visible when an instrumentation window is displayed.
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Console Window

The console window appears below the project or instrumentation window
and displays a history of Identify instrumentor commands that have been
executed, including those executed by menu selections and button clicks.
The Identify instrumentor console window allows you to enter commands as
well as to view the results of those commands. Command history recording is
available through a transcript command (see the Reference Manual).

INFO: D:-Design=-8-bit-verilog-data_mux.v(l): compiling module data_mux _:J
INFO: D:~Designs-8-bit-werilogsalu.w(l): compiling module alu

WARNING: D ~Designs-8-bit—verilog alu.w({83): full case directive iz effective

o might cause synthesis — sinulation differsnces

INFQ: D:rDesigns-8-bit-verilog<ins rom.v{l): compiling module ins rom

INFO: D:rDesigns-8-bit-verilog-=spcl_regs.w(l): comnpiling module spcl_regs

INFO: D:-Design=-8-bit-verilogsio.v{l): compiling module io

INFO: Current design i= “eight_bit_uc’

[ vtoolssident200_021E~-bin% =

When you save your instrumentation (click Save project’s active implementation),
the information at the bottom of the display reports the total number of
instrumented signals to implement in each IICE. To display the resource
estimates for the FPGA device, click the lICEs resource estimation icon.

File Edit Actions Options Help

EEEE =]

e (2D
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Commands and Procedures

The following sections describe basic Identify instrumentor commands and
procedures.

Opening Projects
To launch the Identify instrumentor from the Synplify Pro graphical interface:

1. Right click on the implementation and select New Identify Implementation
from the popup menu.

2. Set/verify any technology, device mapping, or other pertinent options
(see the implementation option descriptions in the Synopsys FPGA
Synthesis User Guide) and click OK. A new, Identify implementation is
added to the synthesis tool project view.

Synplify Pro®

Ready

2Run

Project Files Design Hierarchy

| 1} Open Project...
Microsemi IGLOO+ : AGLPO30V2 : C5201 : 5TD

™ .
| » Close Project | =N 1 [EILIS_demD] - Chdesigns\micro_tut\bus_demo.prj
[ Add File... | x g VHDL
+ rev_1
|&_=i Change File... | ik rev.2

|§E}: Add Implementation...

N\ Identify

Implementation

|{:$} Implementation Options...

3. Either right click on the Identify implementation and select Launch Identify
Instrumentor from the popup menu or click the Launch Identify Instrumentor
toolbar icon to launch the Identify instrumentor.

Launching the Identify instrumentor from the Synplify Pro synthesis tool:
* Brings up the Identify instrumentor graphical interface.

» Extracts the list of design files, their work directories, and the device
family from the project (prj) file.

* Automatically compiles the design files using the synthesis tool compiler
and displays the design hierarchy and the HDL file content with all the
potential instrumentation marked and available for selection.
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When importing a Synplify Pro project into the Identify instrumentor, the
working directory is automatically set from the corresponding project file. See
Chapter 3, Project Handling, for details on setting up and managing projects.

Executing Script Files

A script file is a file that contains Identify instrumentor Tcl commands. A
script file is a convenient way to capture a command sequence you would like
to repeat. To execute a script file, select the File->Execute Script menu selection
in the Identify instrumentor user interface and navigate to the location of
your script file or use the source command (see Chapter 4, Alphabetical
Command Reference, in the Reference Manual).

Selecting Signals for Data Sampling

To select a signal to be sampled, simply click on the watchpoint icon

ijlj' next to the signal name in the Identify instrumentor instrumentation
window; a popup menu appears that allows the signal to be selected
for sampling, triggering, or both.

Sample and trigger Sample and trigger
Sample only Sample anly
Trigger only Trigger anly
v Mot instrumented v Mot inztrumented
Sample Clock . )
E Add partial instrumentation .
Add mus grovp....
SJiEtIE Add vy aroup..

Scalar Signal Popup Bus Signal Popup

To control the overhead for the trigger logic, always instrument signals that
are not needed for triggering with the Sample only selection (the watchpoint
icon is blue for sample-only signals).

Quualified clock signals can be specified as the Sample Clock (see Sample
Clock, on page 36) and bus segments can be individually specified (see
Instrumenting Buses, on page 61). In addition, signals specified as Sample and
trigger or Sample only can be included in mux groups (see Multiplexed Groups,
on page 635).
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< ROOT [bus_dema)

v word_sfer_inst [ward_sfg
o wiord_sfer_cntrl_inst [wo
v blk_sfer_inst [block_xfer

L 1om_inst [whb_rom)
 ram1_inst [wh_ram1]
L raméz_inst [wh_ramz)

32 entity arbiter is

Signals that can be selected

- Ocix
5 ffreset

Soregl

7 direg2

8 gwgrantl :
g gwgrant? :
Vi

1 end arbiter;

3 architecture beh of arjgter is

4 type stghes.d= (=t Jdlel _=r 3gdled st grantl, sSt_grant2);

5 signal{#ecurr state, denext state: sfkates;

If the icon is clear (unfilled), the signal is disabled for sampling (not instru-

mented), and if the icon is red, the signal is enabled for triggering only. If the
icon is blue, the signal is enabled for sampling only, and if the icon is green,
the signal is enabled for both sampling and triggering. In the example below,
notice that when signal “grantl” is enabled, the console window displays the
text command that implements the selection and the results of executing the

command.

Identify Microsemi Edition User Guide
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Signal “grant1” selected

AN

N\

& ROOT [bus_dema)
@ beh

& word_sfer_inst [ward_sfer
o word_sfer_cntrl_inst [word_«
o blk_sfer_inst [block_sfer]
& blk_sfer_cntlingt [blk_xfer_cntrl]
E =ib inst [arbiter]
& ram_ingt [wh_rom)
o raml_inst [wh_ram1]
o ramZ_inst [wh_ramZ]

.std_logic_1164.a211:

.std_logic_arith.all;

i=

32 entity arbiter

port |

U1 fibufa) o::lk in std_logic:
[ulF)

dcmn[dgcm] dfclk sys @ in std logics
clk_bufll_fx (bufg) ddfreset in =td logic;
clk_buf [buf - -

dem [dc:l['n] J dezl in std_logie;

clk_buf [bufg)

% i out std logic

1 std_logics

out =td logic:

end arbiter:

42

i

Kl
@bus_demo_xilinx" @”CE I

kil

C:/designs/bus_demo_¥ilinx$ signals add -sample -trigger -iice TICE {/beh/arb_inst/grantl}

Commands and Procedures

INFC:
INFC:

signals add -sample -trigger -—iice TICE /beh/arb_inst/grantl
)"beh/arb_inst;’grantl added for sampling and triggering to iice: IICE
Total instrumentation in bits: Sample Only 0, Trigger Only O,
Group wise instrumentation in bits:
UnGrouped: Sample Only O,

Sample and trigger 1

Sample and trigger 1

To disable a signal for sampling or triggering, select the signal in the Identify
instrumentor instrumentation window and then select Not instrumented from
the popup menu; the watchpoint icon will again be clear (unfilled).

Note:

You can use Find to recursively search for signals and then
instrument selected signals directly from the Find dialog box (see
Searching for Design Objects, on page 76).
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Instrumenting Buses

Entire buses or individual or groups of bits of a bus can be independently
instrumented.

Instrumenting a Partial Bus
To instrument a sequence (range) of bits of a bus:

1. Place the cursor over a bus that has not been fully instrumented and
select Add partial instrumentation to display the following dialog box.

%% Identify Instrumentor: Add partial instrume... I,&J

Instrument partial slice of signal. 'Ybeh/partial_adrl’ (8 bit)

MSE: |7 LSB: 4 |Sample and trigger j

ak. | Cancel ‘

2. In the dialog box, enter the most- and least-significant bits in the MSB
and LSB fields. Note that the bit range specified is contiguous; to
instrument non-contiguous bit ranges, see the section, Instrumenting
Non-Contiguous Bits or Bit Ranges, on page 62.

Note: When specifying the MSB and LSB values, the index order of the
bus must be followed. For example, when defining a partial bus
range for bus [63:0] (or “63 downto 0”), the MSB value must be
greater than the LSB value. Similarly, for bus [0:63] (or “O upto
63”), the MSB value must be less that the LSB value.

3. Select the type of instrumentation for the specified bit range from the
drop-down menu and click OK.

When you click OK, a large letter “P” is displayed to the left of the bus
name in place of the watchpoint icon. The color of this letter indicates if
the partial bus is enabled for triggering only (red), for sampling only
(blue), or for both sampling and triggering (green).
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277 GeHEH BD. éwHEH UR:
278 [63:0] SyDATA IN:
279 [63:0] [PDATA OUT:

Instrumenting Single Bits of a Bus

To instrument a single bit of a bus, enter the bit value in the MSB field of the
Add partial bus dialog box, leave the LSB field blank, and select the instrumen-
tation type from the drop-down menu as previously described.

Instrumenting Non-Contiguous Bits or Bit Ranges
To instrument non-contiguous bits or bit ranges:

1. Instrument the first bit range or bit as described in one of the two
previous sections.

2. Re-position the cursor over the bus, click the right mouse button, and
again select Add partial instrumentation to redisplay the Add partial bus dialog
box. Note that the previously instrumented bit or bit range is now
displayed.

RTRY_Da&TA_B3 56 L

Add partial instrurmentation ...

3. Specify the bit or bit range to be instrumented as previously described,
select the type of instrumentation from the drop-down menu, and click
OK. If the type of instrumentation is different from the existing
instrumentation, the letter “P” will be yellow to indicate a mixture of
instrumentation types.

Note: Bits cannot overlap groups (a bit cannot be instrumented more
than once).
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Changing the Instrumentation Type
To change the instrumentation type of a partial bus:
1. Position the cursor over the bus and click the right mouse button.

2. Highlight the bit range or bit to be changed and select the new
instrumentation type from the adjacent menu.

RTRY_DAT: BB Sample and trigger
RTRY_DATA_31_24 ¥ w Sample only
Trigger anly

Mot instrumented

Add partial instrumentation ..

Note: The above procedure is also used to remove the instrumentation
from a bit or bit range by selecting Not instrumented from the menu.

Partial Instrumentation

Partial instrumentation allows fields within a record or a structure to be
individually instrumented. Selecting a compatible signal for instrumentation,
either in the RTL window or through the Find dialog box, enables the partial
instrumentation feature and displays a dialog box where the field name and
its type of instrumentation can be entered.

77 Identify Instrumentor: Add partial instrumentation @

Instrument partial zlice of signal; 'Ybeh/bllk_sfer_instAwb_adr_o' [10 bit)

M3B: [7 LSB: [5 {Sample Only |~

l ok | Cancel ‘

When instrumented, the signal is displayed with a P icon in place of the
watchpoint (glasses) icon to indicate that portions of the record are instru-
mented. The P icon is the same icon that is used to show partial instrumenta-
tion of a bus and uses a similar color coding:

* Green indicates that all fields of the record are instrumented for sample
and trigger
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¢ Blue indicates that all fields of the record are instrumented for sample
only

¢ Pink indicates that all fields of the record are instrumented for trigger
only

¢ Yellow indicates that not all fields of the record are instrumented the
same way

The figure below shows the partial instrumentation icon on signal tt. The
yellow color indicates that the individual fields (tt.r2 and tt.c2) are assigned
different types of instrumentation.

31

32 =ignal E‘Q: mnatrix slementl:
33 begin

34 [Pit.r2 <= &5r2:;

35 [Pit.c? <= &gl

36 Pit.ele.rl <= &frl:

37 [Pit.ele.cl <= &fcl:
38

The Find dialog also uses the partial instrumentation icon to show the state of
instrumentation on fields of partially instrumented records.

77 Identify Instrumentor: Find Design El E‘ﬂlﬂ

OF bype: |signa| j
Mamed: *
With statuz; instrumented | 'l
Laok in |/behbll_sfer_inst
InlICE: [nce
I Show hidden elements Find ‘ Cloze ‘

é outl (32 bit) soutl J

&g inb (3 bit) #inb

éd ina (4 bit} ~ina

(D) = dummy_clk Sa_dummy_clk

[ tt (128 bit) szimnplerstt

Note: Partial instrumentation can only be added to a field or record one
slice-level down in the signal hierarchy.
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Multiplexed Groups

Multiplexed groups allow signals to be assigned to logical groups. Using
multiplexed groups can substantially reduce the amount of pattern memory
required during subsequent debugging when all of instrumented signals are
not required to be loaded into memory at the same time.

Only signals or buses that are instrumented as either Sample and trigger or
Sample only can be added to a multiplexed group. To create multiplexed
groups, right click on each individual instrumented signal or bus and select
Add mux group from the popup menu.

v Sample and tigger
Sample anly
Trigger anly
Mot instrumented
Sample Clock,

Add mus group .

In the Add mux group dialog box displayed, select a corresponding group by
checking the group number and then click OK to assign to the signal or bus
to that group. A signal can be included in more than one group by checking
additional group numbers before clicking OK.

-
%4 Identify Instrumentor: Add mux group L&J

Add zignal Ybehdreset’ to mus groups:
M1 T2 I3 4 W#s s 7 [8

Cancel ‘

When assigning instrumented signals to groups:

* A maximum of eight groups can be defined; signals can be included in
more than one group, but only one group can be active in the Identify
debugger at any one time.

¢ Signals instrumented as Sample Clock or Trigger only cannot be included in
multiplexed groups.

¢ Partial buses cannot be assigned to multiplexed groups.
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¢ The signals group command can be used to assign groups from the
console window (see signals, on page 70 of the Reference Manual).
Command options allow more than one instrumented signal to be
assigned in a single operation and allow the resultant group assign-
ments to be displayed.

For information on using multiplexed groups in the Identify debugger see
Selecting Multiplexed Instrumentation Sets, on page 91.

Sampling Signals in a Folded Hierarchy

When a design contains entities or modules that are instantiated more than
once, it is termed to have a folded hierarchy (folded hierarchies also occur
when multiple instances are created within a generate loop). By definition,
there will be more than one instance of every signal in a folded entity or
module. To allow you to instrument a particular instance of a folded signal,
the Identify instrumentor automatically recognizes folded hierarchies and
presents a choice of all possible instances of each signal with the hierarchy.

The choices are displayed in terms of an absolute signal path name

ijlj' originating at the top-level entity or module. The list of choices for a
particular signal is accessed by clicking the watchpoint icon or corre-
sponding signal.

The example below consists of a top-level entity called two-level and two
instances of the repeated_unit entity. The source code of repeated_unit is
displayed, and the list of instances of the val signal is displayed by clicking on
the watchpoint icon or the signal name. Two instances of the signal val are
available for sampling:

/rtl/cnt _inst0/val
/rtl/cnt instl/val

Either, or both, of these instances can be selected for sampling by selecting
the signal instance and then sliding the cursor over to select the type of
sampling to be instrumented for that signal instance.
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The list of instrumentable instances of signal val

I NEe 1eee.=td_logic_arith.all;
4
5
B
7
’ E l& and i
Samgle and trigger
? Fodl] Atlient_ingt] feal # Samfie oy
10 1 — Trigger anly
11 end repeated_unit; v Mot instrumented

The color of the watchpoint icon is determined as follows:
e If no instances of the signal are selected, the watchpoint icon is clear.

e If some, but not all, instances of the signal are defined for sampling, the
watchpoint icon is yellow.

e If all instances are defined for sampling, the color of the watchpoint icon
is determined by the type of sampling specified (all instances sample
only: blue, all instances trigger only: red, all instances sample and
trigger: green, all instances in any combination: yellow).

Alternately, any of the instances of a folded signal can be selected or
deselected at the Identify instrumentor console window prompt by using the
absolute path name of the instance. For example,

signals add /rtl/cnt _instl/val
See the Reference Manual for more information.

To disable an instance of a signal that is currently defined for sampling, click
on the watchpoint icon or signal, select the instance from the list displayed,
and select Not instrumented.

For related information on folded hierarchies in the Identify debugger, see
Activating/Deactivating Folded Instrumentation, on page 91 and Displaying
Data from Folded Signals, on page 100.
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Instrumenting Signals Directly in the idc File

In addition to the methods described in the previous sections, signals can be
instrumented directly within the srs file in the synthesis tool outside of the
Identify instrumentor. This methodology facilitates updates to a previous
instrumentation and also allows signals within a parameterized module,
which were previously unavailable for instrumentation, to be successfully
instrumented. This technique is referred to as “post-compile instrumenta-
tion.” To instrument a signal directly within the synthesis tool using this
technique:

1. Compile the existing instrumented design in the synthesis tool.
2. Open the RTL view (srs file) in the synthesis tool.

3. Highlight the net of the signal to be instrumented.
4

. With the net highlighted, click the right mouse button, select Identify -
Copy TCL from the popup menu, and select the type of instrumentation
to be applied.

Go to Met Driver
Select Met Driver
Select Met Instances
Current Level 4
Properties...
Set Net Color.,

%_‘ Timing Analyst...

Copy

&% Find...

? Filter Schematic
Hide Selected Instances

["] Push/Pep Hierarchy
SCOPE 4
Instrumentor - Copy TCL ¥ Sample and Trigger

Sample Only
Trigger Only
Sample Clock

S. Create a new or open an existing identify.idc file in the designName /rev_n
directory and paste the signal string into the file. The following figure
shows the cntrl_ack o 0_sgmuxa signal (from the block_xfer block) on line
10 being pasted into the file as a sample-only signal.
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iice new [IICE} -type regular
iice controller —-iice [IICE} none
iice sampler —-iice {IICE} -depth 128

signals add -iiee {IICE} -silent -trigger {/3RE/blk_xfer_ inst/entrl_ack_o_0_sgmuxa]
signals add -iiee {IICE} -silent -sample {/beh/arb inst/reset}

signals add -iiee {IICE} -silent —-trigger -sample {/beh/arb_inst/beh/curr_state}\
{/beh/ark inst/beh/next_state]

=y I PR T RSV R

o R Y. & ¥ -

s Frarmje——eis- FEEES dge—peeies et
(: signals add -sample {/5RS/blk xfer inst/entrl_ack_o 0_sgmuxsa}

.
(=)

Note: If you are creating a new identify.idc file, you must add the IICE
definition on lines 1, 2, and 3 to the beginning of the file as
shown in the above figure.

6. Edit the entry and add an -iice option to the line as shown in the example
below (the Copy TCL command does not automatically include the IICE
unit in the entry):

signals add -iice {IICE} -sample
{/SRS/blk xfer inst/cntrl ack o 0 sgmuxa}

7. Save the edited identify.idc file and rerun synthesis.

When you open the Identify debugger, an SRS entry is included in the
hierarchy browser; selecting this entry displays the additional signal or
signals added to the identify.idc file. Selecting a signal in the instrumentation
window brings up the Watchpoint Setup dialog box to allow a trigger expression
to be assigned to the defined signal.

& ROOT [bus_dema) =]
beh

o wword_sfer_ingt [word_sfer) 2 ¢gontrl ack o 0 sgmuxa

ward_xfer_cnbrl_inst [waord_sfer

& blk_sfer_inst [block_xfer)

blk_=fer_cntrl_inzt [blk_sfer_cnl

& arb_inzt [arbiter)

o rom_inst [wh_ram)

& 1ami_ingt [whb_ram1]

L o1am2_ingt [wh_ramz2)

o)
I'_—'I-I—_‘ SRS (SRS
‘ n

1 wiew blk xfer inst instance blk xfer inst

Note that trigger expressions on signals added to the identify.idc file must use
the VHDL style format.
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Selecting Breakpoints

Breakpoints are used to trigger data sampling. Only the breakpoints
4 that are instrumented in the Identify instrumentor can be enabled as
triggers in the Identify debugger. To instrument a breakpoint in the
Identify instrumentor, simply click on the circular icon to the left of the line
number. The color of the icon changes to green when enabled.

Breakpoint on line 23 enabled

16 begin
17 proceg&idiclk, ddclr) begin

14 f fgclr = '0' then

19 fdcurrent state <= = RESET:

20 elzif &gclk'event and Soclk = 'l' then

caze dfcurrent state is

> when =_RESET = ddcurrent state <= = ZERD:
" ] 23 when =_ZERD =» ddcurrent state <= = OHE:
] 24 when = _ONE =: ffcurrent state <= s_TWO;
> 25 when =_TWD = Hfcurrent state (= = THREE:
] 26 when =_THREEE =: ddcurrent state <= = FOUR:
] 27 when = FOUR =: &fcurrent state <= s_FIVE:

Once a breakpoint is instrumented, the Identify instrumentor creates trigger
logic that becomes active when the code region in which the breakpoint
resides is active.

In the above example, the code region of the instrumented breakpoint is
active if the variable current_state is state zero (s_ZERO) and the signal clr is not
‘0’ when the clock event occurs.

Selecting Breakpoints Residing in Folded Hierarchy

If a design contains entities or modules that are instantiated more than once,
the design is termed to have folded hierarchy. By definition, there will be
more than one instance of every breakpoint in a folded entity or module. To
allow you to instrument a particular instance of a folded breakpoint, the
Identify instrumentor automatically detects folded hierarchy and presents a
choice of all possible instances of each breakpoint.
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The choices are displayed in terms of an absolute breakpoint path name
originating at the top-level entity or module. The list of choices for a partic-
ular breakpoint is accessed by clicking on the breakpoint icon to the left of
the line number.

The example below consists of a top-level entity called top and two instances
of the repeated_unit entity. The source code of repeated_unit is displayed; the list
of instances of the breakpoint on line 100 is displayed by clicking on the
breakpoint icon next to the line number. As shown in the following figure,
three instances of the breakpoint are available for sampling.

Any or all of these breakpoints can be selected by clicking on the corre-
sponding line entry in the list displayed.

Folded breakpoint on line 100 selected

95 begin
el then
97 & “gooot;
ag elfif &rclk'event and dgcllk = '1l' then
99 if { dgclr = '0' ) then
& 100 e ¢= Fftmp + 2

Atlffolded?_instQArt ont_inst0AH2 fprocess_ 3447 964F 99 repeated_unit vhd: 100
Atlffolded?_instQAt ont_inet] At fprocess 9447 964F 99 repeated_unit vhd: 100
Atlfent_inst2 2 process_944F 96499/ repeated_unitwhd: 100

104 end if;
105 end process;

The color of the breakpoint icon is determined as follows:
» If no instances of the breakpoint are selected, the icon is clear in color.

e If some, but not all, instances of the breakpoint are selected, the icon is
yellow.

» If all instances are selected, the icon is green.

Alternately, any of the instances of a folded breakpoint can be selected or
deselected at the Identify instrumentor console window prompt by using the
absolute path name of the instance. For example,

breakpoints add
/rtl/inst0/rtl/process 18/if 20/if 23/repeated unit.vhd:24

See the Reference Manual for more information.
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The lines in the list of breakpoint instances act to toggle the selection of an
instance of the breakpoint. To disable an instance of a breakpoint that has
been previously selected, simply select the appropriate line in the list box.

Configuring the IICE

If the IICE configuration parameters for the active IICE need to be

@ changed, use the Actions->Configure IICE menu selection or the Edit IICE
settings icon to change them. Chapter 4, IICE Configuration, discusses
how to set these parameters for both single- and multi-IICE configu-
rations.

Writing the Instrumented Design

To create the instrumented design, you must first complete the following
steps:

1. Define a synthesis project with all source files defined
2. Specify IICE parameters

3. Select signals to sample

4. Select breakpoints to instrument

S

. Optionally include the original HDL source

Note: To include the original HDL source with the project, select
Options->Instrumentation preference from the menu to display the
Instrumentation Preferences dialog box and select the Save original
source in instrumentation directory check box. If the original source is
to be encrypted, additionally select the Use encryption check box.
Selecting Save original source in instrumentation directory saves the orig-
inal HDL source to the orig_sources subdirectory in the instru-
mentation directory when you instrument your design.

© 2015 Synopsys, Inc. Identify Microsemi Edition User Guide
72 March 2015



Commands and Procedures Identify Instrumentor

your instrumentation. Saving a project’s instrumentation generates

an instrumentation design constraints (idc) file and adds compiler

pragmas in the form of constraint files to the design RTL for the
instrumented signals and break points. This information is then used by the
Synplify Pro synthesis tool to incorporate the instrumentation logic (IICE and
COMM blocks) into the synthesized netlist. If you are including an encrypted
HDL source (Use encryption box checked), you are first prompted to supply a
password for the encryption.

IE Finally, click on the Save project’s active instrumentation icon to capture

Including Original HDL Source

Including the original HDL source with the instrumented project simplifies
design transfer when instrumentation and debugging are performed on
separate machines and is especially useful when a design is being debugged
on a system that does not have access to the original sources.

As explained in Debugging on a Different Machine, on page 110, you can
simply copy the entire implementation directory to the debug system; the
Identify project will be able to locate the original sources for display. To
include the original HDL source, select the Save original source in instrumentation
directory check box from the Instrumentor Preferences dialog box (Options->Instru-
mentation preferences) before you save and instrument your project. The clear
text or encrypted source is included in the orig_sources subdirectory.

When the Use encryption check box is additionally selected, the original sources
are encrypted when they are written into the orig_sources subdirectory. The
encryption is based on a password that is requested when you write out the
instrumented project. Encryption allows you to debug on a machine that you
feel would be too unsecure to store your sources. After you transfer the
instrumentation directory to the unsecure machine, you are prompted to
reenter the encryption password when you open the project in the debugger.

For maximum security when selecting an encryption password:

* use spaces to create phrases of four or more words (multiple words
defeat dictionary-type matching)

¢ include numbers, punctuation marks, and spaces

* make passwords greater than 16 characters in length
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Note: Passwords are the user’s responsibility; Synopsys cannot recover
a lost or forgotten password.

The decrypted files are never written to the unsecure machine’s hard disk.
Users are discouraged from transferring the instr_sources directory to the
unsecure machine, as this directory is not required for debugging.

Synthesizing Instrumented Designs

When you save your instrumentation, the following files and subdirectories
are updated or created in the synthesis project implementation directory
(projectName /rev_n):

e an identify.idc file describing the instrumented watchpoints and break-
points; this file can be manually edited to add additional watchpoints
(see Instrumenting Signals Directly in the idc File, on page 68).

¢ instr_sources subdirectory containing:
— the IICE core file (syn_dics.v)

— a Synopsys FPGA constraints file (syn_dics.sdc) — this file is used
directly by the Synplify Pro synthesis tool

— a Synopsys FPGA compiler design constraints file (syn_dics.cdc)

e an optional orig_sources subdirectory containing the original HDL files in
either encrypted or clear-text format

e an identify.db encrypted data file

Note: When instrumenting a VHDL file that is not compiled into the
work library, make sure that the syn_dics.vhd file is included in
the synthesis project ahead of the user design files. Additionally,
this file must be compiled into the work library.
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Listing Signals
The Identify instrumentor includes a set of menu commands and, in most
cases, icons for listing watchpoint and breakpoint conditions.

List Instrumented Signals

use the Actions->Show Instrumented Signals menu selection or click the
Show Instrumented Signals icon. The result of listing the signals is
displayed in the Find dialog box.

? To view all of the signals currently instrumented in the entire design,

| OF type: |signa|

[ InlICE: |nce
™ Show hidden elements

(2 clk /ben/clk

¢ reset /beh/reset

é& centrl_ack? /beh/ccntrl ack2

= ccntrl req?2 /beh/ccntrl req2

& centrl_ackl /beh/ccntrl _ackl

o=t centrl reql /beh/centrl reql

é& slave_num writel (2 bit) /beh/slave num writel
= slave num readl (2 bit) /beh/slave num readl

Finished |9 items found,

List All Signals

To view all of the signals in the design, use the Actions->Show All Signals menu
selection.

List Signals Available for Instrumentation

— To see only the signals in the design available for instrumentation,
A use the Actions->Show Possible Signals menu selection or the Show
= Possible Signals icon.
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List Instrumented Breakpoints
To list all of the breakpoints that have been instrumented, use the

Actions->Show Instrumented Breakpoints menu selection or the Show Instru-
mented Breakpoints icon.

List All Breakpoints

To list all breakpoints, use the Actions->Show All Breakpoints menu selection.

List Breakpoints Available for Instrumentation

To list all of the breakpoints that are available for instrumentation,
-D. use the Actions->Show Possible Breakpoints menu selection or the Show
Possible Breakpoints icon.

Searching for Design Objects

The Find dialog box is a general utility to recursively search for
signals, breakpoints, and/or instances. To invoke the Find dialog box,
use the Edit->Find menu selection or the Display find dialog icon.

The Find dialog box has an area for specifying the objects to find and
an area for displaying the results of the search.
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Search Specification Search Results

i Identify Instrumeglor: Find Design Eleme

UF type: |signa|
M amed: [

With status: |instrumented

Look, in:

In 1ICE:

P
(2 clk /ben/clk
¢ reset /beh/reset
é& centrl_ack? /beh/ccntrl ack2
= ccntrl req?2 /beh/ccntrl req2
& centrl_ackl /beh/ccntrl _ackl
o=t centrl reql /beh/centrl reql
é& slave_num writel (2 bit) /beh/slave num writel
= slave num readl (2 bit) /beh/slave num readl

| Finished |9 items found,

The search specification includes these options:

» Oftype: — specify which type of object to search for: breakpoint, signal,
instance, or “*” (any). The default is “*” (any).

Named: — specify a name, or partial name to search for in the design. Wild
cards are allowed in the name. The default is “*” (any).

With status: — specify the status of the object to be found. The values can
be instrumented, sample trigger, sample_only, trigger_only, not-instrumented, or “*”
(any). The default is “*” (any).

Look in: — specify the location in the design hierarchy to begin the recur-
sive search. The root (“/”) is the default setting.

In lICE: — a read-only field that indicates which IICE is to be searched
when multiple IICEs are defined. To search another IICE, close the Find
dialog box, click the desired IICE tab, and reopen the Find dialog box.

The search specification also includes a Show hidden elements check box. When
this check box is enabled, the search also includes objects that would not
normally be searched such as breakpoints in dead code.
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The search results window shows each object found along with its hierar-
chical location. In addition, for breakpoints and signals, the results window
includes the corresponding icon (watchpoint or breakpoint) that indicates the
instrumentation status of the qualified signal or breakpoint.

To change the instrumentation status of a signal, click directly on the watch-
point icon and select the instrumentation type from the popup menu. To
toggle the instrumentation status of a breakpoint, click the breakpoint icon.
You also can use the Ctrl and Shift keys to select multiple breakpoints and
then apply the change to all selected breakpoints from the popup menu.

& word_xfer w:104, 37 sword_=fer_
& word_xfer w:10 sword_xfer
J . [ |_|1 R
=N ord =T . =r_|
& word_xfer w: sword_=xfer_
FRvord xfer. v:95% oz L
4 word_xfer w: All breakpaints: |mgtrument

& word_zfer w82 22 Remove

& word_xfer w:88,21 Syword_xter
& word _=zfer. w:97,22 sword_=fer

Console Text

© 2015 Synopsys, Inc.
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To capture all text written to the console, use the log console command (see
the Reference Manual). Alternately, you can click the right mouse button
inside the console window and select Save Console Output from the menu.

To capture all commands executed in the console window use the transcript
command (see the Reference Manual).

To clear the text from the console, use the clear command or click the right
mouse button from within the console window and select Clear from the
menu.
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celerating Innovation

CHAPTER 7

|dentify Debugger

The Identify debugger enables HDL designs to be debugged by interacting
with the instrumented HDL design implemented in the target hardware
system. You can activate breakpoints and watchpoints to cause trigger events
within the IICE on the target device. These triggers cause signal data to be
captured in the IICE. The data is then transferred to the Identify debugger
through a communications port where it can be displayed in a variety of
formats.

This chapter describes:
* Invoking the Identify Debugger, on page 80
* Identify Debugger Windows, on page 81
e Commands and Procedures, on page 86
* Console Text, on page 107
e Waveform Display, on page 108
e Debugging on a Different Machine, on page 110

e Simultaneous Debugging, on page 111
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Invoking the Identify Debugger

The Identify debugger can be launched directly from a synthesis project or
the Identify debugger can be explicitly opened directly from a Windows or
Linux system.

Synplify Pro Tool Launch

To invoke the Identify debugger directly from the Synplify Pro graphical user
interface, highlight the Identify implementation and select Run->Launch Identify
Debugger from the menu bar or popup menu, or click the Launch Identify
Debugger icon in the top menu bar.

The Identify debugger IICE instrumentation window opens with the corre-
sponding project displayed (see Instrumentation Window, on page 82).

Operating System Invocation

The Identify debugger runs on both the Windows and Linux platforms. To
explicitly invoke the debugger from a Windows system, either:

¢ double click the Identify Debugger icon on the desktop

e run identify_debugger.exe from the /bin directory of the installation path

To explicitly invoke the Identify debugger from a Linux system:

e run identify_debugger from the /bin directory of the installation path

The initial Identify debugger project window opens. To display the instrumen-
tation window, do either of the following:

¢ Click the Open existing project icon in the menu bar and, in the Open Project
File dialog box, navigate to the project directory and open the corre-
sponding project (prj) file.

¢ Select File->Open project from the main menu and, in the Open Project File
dialog box, navigate to the project directory and open the corresponding
project (prj) file.

The Identify instrumentation (IICE) window opens with the corresponding
project displayed (see Project Window, on page 84).
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|ldentify Debugger Windows

The Graphical User Interface for the Identify debugger has three major areas:
e IICE instrumentation window
¢ Console window

* Project window

In this section, each of these areas and their uses are described. The
following discussions assume that:

* a project (with an HDL design) has been loaded into the Identify instru-
mentor and instrumented

* the design has been synthesized in your synthesis tool

* the synthesized output netlist has been placed and routed by the place
and route tool

* the resultant bit file has been used to program the FPGA with the
instrumented design

e the board containing the programmed FPGA is cabled to your host for
analysis by the Identify debugger
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Instrumentation Window

The instrumentation window in the Identify debugger, like the instrumenta-
tion window in the Identify instrumentor, includes a hierarchy browser on
the left and the source code display on the right.

,

File Edit Debug Options Window Help

o] )= 4| BH <& B
Sd %0 [BEE - 138 EEEE @ B
Complex Counter kode: | events | Walee |1 Sample Mode: | noimal || Cross trigger mode: | afterlICE_0 = @
|
© ROOT bus demo) =] - 4|
‘ beh 20 entity bus_demo i=
&> word_xler_inst[v?lord_ 31 generic |( —
o word_ster_cnbrl_inst [ i o .
& blk_sfer_inst [black_s 32 data width : positive := §;
& blk_sfer_cntil_inst (bl 33 addr width : positive := 10;
& arb_inzt [arbiter] -
& rom_inst [wh_rom) 34 zlave addr size: positive := 2
o rami_ingt (wh_ram1] 35 )z
o ramZ_inst [wh_ram2) o
36 port |
37 clk : in std logic;
38 adr_o: out std_logic_wvector (addr width-1 downto 0);
39 dat_o: out std_logic vector (data width-1 downto 0)
40 1
41 end bus demo;
42
- - - - - - - - - hd
K I K1

(3 bus_demo* SEMCE I

Hierarchy Browser Source-Code Display

Hierarchy Browser

The hierarchy browser on the left shows a graphical representation of the
design’s hierarchy. At the top of the browser is the ROOT node. The ROOT
node represents the top-level entity or module of your design. For VHDL
designs, the first level below the ROOT is the architecture of the top-level
entity. The level below the top-level architecture for VHDL designs, or below
the ROOT for Verilog designs, shows the entities or modules instantiated at
the top level.
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Clicking on a + sign opens the entity/module instance so that the hierarchy
below that instance can be viewed. Lower levels of the browser represent
instantiations, case statements, if statements, functional operators, and other
statements.

o word_zfer_inzst [ward_xfer]
o word_sfer_chtl_ingt [word_sfer_cntrl]
& beh
o lFer_ingt (Ifer)
process_109
& process 137
‘ process 147

Single clicking on any element in the hierarchy browser causes the associ-
ated HDL code to be displayed in the adjacent source code window.

Source Code Display

The source code display shows the HDL source code annotated with signals
and breakpoints that were previously instrumented.

Note: Signals and breakpoints that were not enabled in the Identify
instrumentor are not displayed in the Identify debugger.

Signals that can be selected for setting watchpoints are underlined, colored in
blue text, and have small watchpoint (or “P”) icons next to them. Breakpoints
that can be activated have small green circular icons in the left margin to the
left of the line number.

44  begin
45 defgrantl <= '0';
16 fogrant? <= '0';
47
48 case {curr state) is
49 when st_idlel =»
50 if { ggregl = '1' ) and { & req2 = '1' ) then
@ 51 next_state <= st_grant2;
52 elsif { &gregl = '1' ) then
3 53 next_state <= st_grantl;
54 elsif { &g reg2 = '1' ) then
@ 55 next_state <= st_grant2;
56 else
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Selecting the watchpoint or “P” icon next to a signal (or the signal itself)
allows you to select the Watchpoint Setup dialog box from the popup menu. This
dialog box is used to specify a watchpoint expression for the signal. See
Setting a Watchpoint Expression, on page 87.

Selecting the green breakpoint icon to the left of the source line number
causes that breakpoint to become armed when the run command is executed.
See Run Command, on page 94.

Console Window

The Identify debugger console window displays commands that have been
executed, including those executed by menu selections and button clicks.
The Identify debugger console window also allows you to type Identify
debugger commands and to view the results of command execution.

D »DESIGHS-5YH_COUNTER: project open —reapply {D: /D881gns/syn counterssyn_counter . bsp}
INFO: Changed working directory to "D: /D831gns/syn counter"”

INFO: Loading design instrumentation wersion 4.0

INFO: Created Mon Jan 06 10:41:00 2003

INFOQ: User = garvl

INFO: Flatform = windows
INFO: Machine Name = GARYZ2
INFO: Machine Type = intel
IHFD: 05 = Windows HT
INFQ: QS wersion = E&.0

INFO: Using instrumentation in "D:-Design=-=yn_counter-syn_syn_counter"
D: /DESIGHS-SYH_COUNTERS

Project Window

An empty project window is displayed when you explicitly start up the
Identify debugger. The window is replaced by the instrumentation window
when the synthesis project (prj) file is read into the Identify debugger.

The project window is restored at any time by clicking its tab at the bottom of
the window.
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Identify Debugger

Identify Debugger - [C:/desi
File Edit Debug Options Window Help

SH 4

EgE -

j Walue: ‘1

Complex Counter Made: Ievents

‘ Sample Mnde:lnormal = ‘ Cross trigger mode: Iafter-IICE_D - @

= bus_demo™
= vhdl

[V IICE

V¥ IICE_D

0 o

— Communication setting

Cable type: [Microsemi_Builinl TAG

Show chain ...

Port seftings .. |

]
|

Caomm check ... |

— Instrumentation zetting

Device family: iglooplus
Communication port: builtin

Skew Free: off

""" bus_demo* | h#AIICE | (AIICE_D

The project window displays the symbolic view of the project on the left and a
Run button with a list of all of the available IICE units that can be debugged

on the right.

Identify Microsemi Edition User Guide
March 2015

© 2015 Synopsys, Inc.
85



Identify Debugger Commands and Procedures

Commands and Procedures

This section describes the typical operations performed in the Identify
debugger.

Opening and Saving Projects

The Identify debugger commands to open and save projects are available as
menu items and icons.

Function Menu Bar Menu Command
Icon

Open existing project l File->Open project

Save current File->Save activations

activations

When opening a project:

¢ The working directory is automatically set from the corresponding
project file.

* If the project was saved with encrypted original sources, you are
prompted to enter the original password used to encrypt the files. This
password is then used to read any encrypted files.

See Chapter 3, Project Handling, for details on setting up and managing
projects.

Executing a Script File

A script file contains Identify Tcl commands and is a convenient way to
capture a command sequence that you would like to repeat. To execute a
script file, select the File->Execute Script menu selection and navigate to your
script file location or use the source command (see Chapter 4, Alphabetical
Command Reference, in the Reference Manual).
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Activating/Deactivating an Instrumentation

The trigger conditions used to control the sampling buffer comprise break-
points, watchpoints, and counter settings (see Chapter 8, IICE Hardware
Description). Activation and deactivation of breakpoints and watchpoints are
discussed in this chapter.

Setting a Watchpoint Expression

Any signal that has been instrumented for triggering can be activated as a
watchpoint in the Identify debugger. A watchpoint is defined by assigning it
one or two HDL constant expressions. When a watched signal changes to the
value of its watchpoint expression, a trigger event occurs.

A watchpoint is set on a signal by clicking-and-holding on the signal

|j;j" or the watchpoint icon next to the signal and then selecting the Set
Trigger Expressions menu item to bring up the Watchpoint Setup dialog
box.

A watchpoint is set on a partial bus signal by clicking-and-holding
E‘ on the signal or the “P” icon next to the signal, selecting the partial

bus group from the list displayed, and then selecting the Set Trigger

Expressions menu item to bring up the Watchpoint Setup dialog box.

There are two forms of watchpoints: value and transition.

* A value watchpoint triggers when the watched signal attains a specific
value.

* A transition watchpoint triggers when the watched signal has a specific
value transition.

To create a value watchpoint, assign a single, constant expression to the
watchpoint. A value watchpoint triggers when the watched signal value
equals the expression. In the following example, the signal is a 4-bit signal,
and the watchpoint expression is set to “0010” (binary). Any legal VHDL or
Verilog (as appropriate) constant expression is accepted.
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Setup the first walue anly to watch a value in a pattern tree on signal "'nest_state”
or both values bo watch a transition from the firgt to the second in a pattern tree;

Language: [whdl |

First value Second value [optional]

oo

To create a transition watchpoint, assign two constant expressions to the
watchpoint. A transition watchpoint triggers when the watched signal value
is equal to the first expression during a clock period and the value is equal to
the second expression during the next clock period. In the example below, the
transition being defined is a transition from “0010” to “1011.”

Setup the first value only to watch a value in a pattern tree on signal "nest_state”
o both walues to watch a transition from the firgt to the zecond in a pattern tree;

Language: |swhdl |
First value Second value [optional]

omo 1o

Cancel

The VHDL or Verilog expressions that are entered in the Watchpoint Setup
dialog box can also contain “X” values. The “X” values allow the value of some
bits of the watched signal to be ignored (effectively, “X” values are don’t-care
values). For example, the above value watchpoint expression can be specified
as “X010” which causes the watchpoint to trigger only on the values of the
three right-most bits.
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Hexadecimal values can additionally be entered as watchpoint values using
the following syntax:

x"hexValue"

As shown, a hexadecimal value is introduced with an x character and the
value must be enclosed in quotation marks. Similarly, you can include a

hexadecimal entry in an equivalent Tcl command by literalizing the quote
marks with back slashes as shown in the following example:

watch enable -iice IICE -condition 0 /structural/reg fout x\"aa\"

Clicking OK on the Watchpoint Setup dialog box activates the watchpoint (the
watchpoint or “P” icon changes to red) which is then armed in the hardware
the next time the Run button is pressed.

Deactivating a Watchpoint

By default, a watchpoint that does not have a watchpoint expression is
inactive. A watchpoint that has a watchpoint expression can be temporarily
deactivated. A deactivated watchpoint retains the expression entered, but is
not armed in the hardware and does not result in a trigger.

To deactivate a watchpoint, click-and-hold on the signal or the
|j;j" associated watchpoint icon. The watchpoint popup menu appears.

To deactivate a partial-bus watchpoint, click-and-hold on the signal
or the associated “P” icon and select the bus segment from the list of
segments displayed. The watchpoint popup menu appears.

v Sample

Change signal radix ...

Set trigger exprezzions ...

The Watch menu selection will have a check mark to indicate that the watch-
point is activated. Click on the Watch menu selection to toggle the check mark
and deactivate the watchpoint.
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Reactivating a Watchpoint

To reactivate an inactive watchpoint, click-and-hold on the signal or the
associated watchpoint or “P” icon. Clicking the watchpoint icon redisplays the
watchpoint popup menu: clicking the “P” icon, lists the partial bus segments;
select the bus segment from the list displayed to display the watchpoint
popup menu. Click on the Watch menu selection to toggle the check mark and
reactivate the watchpoint.

Activating a Breakpoint

Instrumented breakpoints are shown in the Identify debugger as green icons
in the left margin adjacent to the source-code line numbers. Green break-
point icons are inactive breakpoints, and red breakpoint icons are active
breakpoints. To activate a breakpoint, click on the icon to toggle it from green

to red.
Active breakpoint (red)

62 when = EIGHT =»

] 63 ggcurrent state <= = HINE:
64 when = HIHNE =:
65 decurrent state <= = TEHN:
13 when = TEH =»
67 ggcurrent state <= = ELEVEN:
6a when = ELEVEN =:

@ 64 égcurrent state <= = TWELVE:

\K when =_TWELVE =»

Inactive breakpoint (green)

To deactivate an active breakpoint, click on the breakpoint icon to toggle it
from red to green.
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Selecting Multiplexed Instrumentation Sets

Multiplexed groups of instrumented signals defined in the Identify instru-
mentor can be individually selected for activation in the Identify debugger (for
information on defining a multiplexed group in the Identify instrumentor, see
Multiplexed Groups, on page 65).

Using multiplexed groups can substantially reduce the amount of pattern
memory required during debugging when all of the originally instrumented
signals are not required to be loaded into memory at the same time.

To activate a predefined multiplexed group in the Identify debugger:

1. Click on the IICE icon in the top menu to display the Enhanced Settings for
[ICE Unit dialog box.

¢ Enhanced Settings for ICE Unit TCE' (SeE.dem)

[rata Compresgion

™ Enable

tux Group

B

2. Use the drop-down menu in the Mux Group section to select the group
number to be active for the debug session.

3. The signals group command can be used to assign groups from the
console window (see signals, on page 70 of the Reference Manual).

Activating/Deactivating Folded Instrumentation

If your design contains entities or modules that are instantiated more than
once, the design is termed to have a “folded” hierarchy (folded hierarchies
also occur when multiple instances are created within a generate loop). By
definition, there will be more than one instance of every signal and break-
point in a folded entity or module. During instrumentation, it is possible to
instrument more than one instance of a signal or breakpoint.
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When debugging an instrumented design with multiple instrumented
instances of a breakpoint or signal, the Identify debugger allows you to
activate /deactivate each of these instrumented instances independently.
Independent selection is accomplished by displaying a list of the instru-
mented instances when the breakpoint or signal is selected for activa-
tion/deactivation.

Activating/Deactivating a Folded Watchpoint

The following example consists of a top-level entity called folded2 and two
instances of the repeated_unit entity. The source code of repeated_unit is
displayed. In this folded entity, multiple instances of the signal val and the
breakpoint at line 24 (not shown) are instrumented.

To activate/deactivate instances of the val signal, select the watchpoint icon
next to the signal. A list will pop up with the two instrumented instances of
the signal val available for activation/deactivation:

/rtl/cnt inst0/val
/rtl/cnt instl/val

Either of these instances is activated/deactivated by clicking on the appro-
priate line in the list box to bring up the watchpoint menu shown in the
following figure.

5 entity repeated_unit i=s

& port
7 clr : in =td_logic:
8 lﬁ:l’E_ 1 . P T B
3 1 I
e fitlien
10 ;
11 end repeated_unit:
12

13 architecture rtl of repeated_unit i=s
14 begin

15

16 dewal <= clk and clx;
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The color of the watchpoint icon is determined as follows:

e If no instances of the signal are activated, the watchpoint icon is green

in color.

* If some, but not all, instances of the signal are activated, the watchpoint

icon is yellow in color.

e If all instances are activated, the watchpoint icon is red in color.

For related information on folded hierarchies, see Sampling Signals in a
Folded Hierarchy, on page 66 and Displaying Data from Folded Signals, on

page 100.

Activating/Deactivating a Folded Breakpoint

To activate/deactivate instances of the breakpoint on line 24, select the icon
next to line number 24. A list will pop up with the two instrumented
instances of the breakpoint available for activation/deactivation:

/rtl/inst0/rtl/process 18/if 20/if 23/repeated unit.vhd:24
/rtl/instl/rtl/process 18/if 20/if 23/repeated unit.vhd:24

Either of these instances can be activated/deactivated by clicking on the

appropriate line in the list box.

The list of instrumented instances

entity repeated wmit
port(

clk  AlAnstlAaal
¥
end repeated wnat;

architecture rtl of repeated
signal tmp : wnsigued ( 3 4

AtlAnstdAvtlprocess 18A4F_204F_23/repeated _unit vhd:24
AtlAnst1tlprocess_18/4F_204fF_23/repeated_unit vhd:24

D

begin
if c¢lx = 'O then
tmp <= "0000";

EEMHIEBﬁEumqm

b
[

The color of the breakpoint icon is determined as follows:
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¢ If no instances of the breakpoint are activated, the breakpoint icon is
green.

e If some, but not all, instances of the breakpoint are activated, the break-
point icon is yellow.

e If all instances are activated, the breakpoint icon is red.

Run Command

The Run command sends watchpoint and breakpoint activations to the IICE,
waits for the trigger to occur, receives data back from the IICE when the
trigger occurs, and then displays the data in the source window.

select Debug->Run from the menu or click the Arm selected IICE(s) for

triggering icon. If data compression is to be used on the sample data,
see Sampled Data Compression, on page 95. To execute the Run command for
multiple IICE units, open the project window (click the project window tab),
enable the individual IICE units by checking their corresponding boxes, and
either click the large Run button or select Debug->Run from the menu.

Run ‘

¥ IICE
¥ IICE_D

| To execute the Run command for the active IICE (or a single IICE),

¥ IICE_1

After the Run command is executed, the sample of signal values at the trigger
position is annotated to the HDL code in the source code window. This data
can be displayed in a waveform viewer (see the Identify debugger waveform
command) or written out to a file (see the Identify debugger write vcd
command).

Note: In a multi-IICE environment, you can edit and run other IICEs
while an IICE is running. The icons within the individual IICE
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tabs indicate when an IICE is running (rotating arrow) and when
an IICE has new sample data (green check mark).

The following example shows a design with one breakpoint activated, the
breakpoint triggered, and the sample data displayed. The small green arrow
next to the activated breakpoint in the example indicates that this breakpoint
was the actual breakpoint that triggered. Note that the green arrow is only
present with simple triggering.

Activated and triggered breakpoint Sampled data (in yellow)

_— —

éﬁgxamtE'n' «='0';

case [curr_state) is
when st _idlel =»

if [ doreql'D’ = '1' ) and [ dwreq2'l’ = '1' ) the
next_state <= st_grant2;

elsif { doreql'D’ = '1' ) then
next_state ¢= st_grantl;

elsif { dwreq2'l’ = '1' ) then
next_state <= st_grant2;

else
next_state <= st_idlel;

end 1f;

Sampled Data Compression

A data compression mechanism is available to compress the sampled data to
effectively increase the depth of the sample buffer without requiring any
additional hardware resources. When enabled, data compression is applied to
the sampled data to temporarily remove any data that remains unchanged
between cycles (a sample is automatically taken after 64 unchanging cycles).

Data compression is enabled from the project view by clicking the IICE icon to
display the Enhanced Settings for IICE Unit dialog box and clicking the Enable
check box in the Data Compression section or from the command prompt by
entering the following command:

iice sampler -datacompression 1
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Data compression must be set prior to executing the Run command and
applies to all enabled IICE units. Data compression is not available when
using state-machine triggering, or qualified or always-armed sampling.

Sample Data Masking

A masking option is available with data compression to selectively mask
individual bits or buses from being considered as changing values within the
sample data. This option is only available through the Tcl interface using the
following syntax:

iice sampler -enablemask 0 |1 [-msb integer -Isb integer] signalName

For example, the following command masks bits O through 3 of vector signal
mybus|7:0] from consideration by the data compression mechanism:

iice sampler -enablemask 1 -msb 3 -1sb 0 mybus

Similarly, to reinstate the masked signals in the above example, use the
command:

iice sampler -enablemask 0 -msb 3 -1lsb 0 mybus

Sample Buffer Trigger Position

The purpose of the activated watchpoints and breakpoints is to cause a
trigger event to occur. The trigger event causes sampling to terminate in a
controlled fashion. Once sampling terminates, the data in the sample buffer
is communicated to the Identify debugger and then displayed in the GUI.

The sample buffer is continuously sampling the design signals. Conse-
quently, the exact relationship between the trigger event and the termination
of the sampling can be controlled by the user. Currently, the Identify
debugger supports the following trigger positions relative to the sample
buffer:

e Early
e Middle
e Late

Determining the correct setting for the trigger position is up to the user. For
example, if the design behavior of interest usually occurs after a particular
trigger event, set the trigger position to “early.”
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The trigger position can be changed without requiring the design to be
reinstrumented or recompiled. A new trigger position setting takes effect the
next time the Run command is executed.

Early Position

+— [Lhe sample buffer trigger position can be set to “early” so that the
I# majority of the samples occurs after the trigger event. To set the
trigger position to “early,” use the Debug->Trigger Position->early menu
selection or click on the Set trigger position to early in the sample buffer icon.

Middle Position

The sample buffer trigger position defaults to “middle” so that there is
an equal number of samples before and after the trigger event. To set
the trigger position to “middle,” use the Debug->Trigger Position->middle

menu selection or click on the Set trigger position to the middle of the sample
buffer icon.

ENRH
g0[ |

Late Position

—7 [Lhe sample buffer trigger position can be set to “late” so that the
t—H majority of the samples occurs before the trigger event. To set the
trigger position to “late,” use the Debug->Trigger Position->late menu
selection or click on the Set trigger position to late in the sample buffer icon.

Stop Command

The Stop command sends control back to the Identify debugger after
you have armed the trigger, but before the trigger occurs. The Stop
command can be executed by selecting Debug->Stop from the menu or
by clicking the Stop debugging hardware icon.

Note: If you are running the IICE from the project window using the
Run button and IICE check boxes (multi-IICE mode), you can
stop a run by clicking the STOP icon adjacent to the check box.

Identify Microsemi Edition User Guide

© 2015 Synopsys, Inc.
March 2015 97



Identify Debugger Commands and Procedures

Sampled Data Display Controls

The sampled data display controls are used to navigate through the data
values captured by the sample buffer. All sample buffer data is tagged with a
cycle number based on when the data item was stored in the sample buffer
relative to the trigger event. The data item stored at the trigger event time has
cycle number O, the data item stored one sample clock cycle after the trigger
has cycle number 1, and the data item stored one sample clock cycle before
the trigger has cycle number -1. The data display procedures allow you to
retrieve data values for a specific cycle number.

The sampled data displayed in the Identify debugger is controlled by the Cycle
text field. You can manually change the cycle number by typing a number in
the entry field. Also, the up and down arrows to the right of the cycle number
increment or decrement the cycle number for each click.

B

(I

VaF * Sampled data
display controls

24 entity counter _self i=
25 port(

To reset the cycle number to the default position (the zero time
EE position), use the Debug->Cycle->home menu selection or click on the
Goto trigger event in sample history icon.
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Radix

The radix of the sampled data displayed can be set to any of a number of
different number bases. To change the radix of a sampled signal:

1. Right click on the signal name or the watchpoint or “P” icon and select
Change signal radix to display the following dialog box.

& Change signal radix for signal: ‘wb_adr_o’ Lﬁ

& Select the desired radix for 10 bit wide signal:
@ ‘fbehdbll_sfer_instAwb_adr_o'

" Select the zame radix for each instumented weckar

default
binary
octal
integer
unsigned

hexadecimnal

LCancel

2. Click the corresponding radio button.
3. Click OK.

Note: You can change the radix before the data is sampled. The watch-
point signal value appears in the specified radix when the
sampled data is displayed.

Specifying default resets the radix to its initial intended value. Note that the
radix value is maintained in the “activation database” and that this informa-
tion will be lost if you fail to save or reload your activation. Also, the radix set
on a signal is local to the Identify debugger and is not propagated to any of
the waveform viewers.

Note: Changing the radix of a partial bus changes the radix for all bus
segments.
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Displaying Data from Folded Signals

If your design contains entities or modules that are instantiated more than
once, it is termed to have a “folded” hierarchy (folded hierarchies also occur
when multiple instances are created within a generate loop). By definition,
there will be more than one instance of every signal in a folded entity or
module. During instrumentation, it is possible to instrument more than one
instance of a signal.

When debugging an instrumented design with multiple instrumented
instances of a signal, the Identify debugger allows you to display the data
values of each of these instrumented signals.

Because multiple data values cannot be displayed at the same location, a
single data value is always displayed. For multiply instrumented signals, the
Identify debugger displays an ellipsis (...) to indicate that there are multiple
values present. To display all of the instrumented values, click-and-hold on
the ellipsis indicator.

The example below consists of a top-level entity called top and two instances
of the repeated_unit entity. In the example, the source code of repeated_unit is
displayed, and both of the lists of instances of the signal val have been instru-
mented. The two instances are /rtl/inst0/val and /rtl/inst1/val, and their data
values are displayed in the pop-up window as shown in the following figure:

Indicator of folded data Data values for instances of folded signal val
h
[ emki eated wmit is
7 poxti
& c - in std_logic:
9 goval: -+ : out unsidhed ( 3 downto 0 );
10 clk - i AtlAnstlAval - 1100
11 ) AtlAinst0Aval -> 0110
1z end repeated wmit;

For related information on folded hierarchies, see Sampling Signals in a
Folded Hierarchy, on page 66 and Activating/Deactivating Folded Instrumen-
tation, on page 91.
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Displaying Data for Partial Buses

When debugging designs with partially instrumented buses, the Identify
debugger displays the data values of each of the instrumented segments.

To display the instrumented values for the individual bus segments, position
the cursor over the composite bus value. The individual partial bus values
are displayed in a tooltip in the specified radix as shown in the following
figure.

Composite bus value Data values of partial buses
342
343 dewr cnd;
: 64 'h3fad?910d177773
e (63:0) #Fdata in . ata_in_B3_32 » 32h3fad7910
345 [63:0] fifdata outh4'5111111001110011 fdata_in_7_0-> 8'h3E 11
246 Adata_in_31_24 > B'hd1

Note that in the above figure, the question marks (?) in the composite bus
value (64' h3fad7910d1?7??736) indicate that the corresponding segment (data_in
[23:8]) has not been instrumented.

Displaying Data for Partial Instrumentation

In the Identify debugger, the value for a fully instrumented record or struc-
ture is shown with a value for each field, in field order. The following figure
shows instrumented signal sig_iport_P_Struc_instr. When displaying a partially
instrumented bus, the value U is used for the uninstrumented slices. This
same notation is used to show the data values for a partially instrumented
record or structure (the value for each instrumented field is listed in field
order, and an uninstrumented field value is shown as a U).
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10 module uddt_P Struc tbtop

11 Dclk ip,

12 type_Unsigned_F_Struc_data Psiq oport P Struc data
13 )

14

15 logic é’a’;g 251:,_1']31:

1t shortint unsigned fer=t cnth5535;

17

15 type_P_Struc_instr ¥sig iport P Struc instrCHP {{4'b0O000} {4'b0O010}}
13

20 alvays @ (posedge @clk im) rzt generation

The Find dialog in the Identify debugger shows a partially instrumented signal
with the P icon. You can set the trigger expressions on the fields instru-
mented for triggering in the same manner as if the signal was fully instru-
mented (that is, select the signal, right click to bring up the dialog, and select
the option to set the trigger expression).

Saving and Loading Activations

The Identify debugger includes a “capture and replay” function that allows
you to save and load a set of enabled watchpoints and breakpoints referred to
collectively as an “activation.” Each activation can additionally include the
sample data set that was captured for a given trigger condition. Activations
are stored in files with an adb extension in a project’s instrumentation subdi-
rectory.

Saving an Activation

An activation can be explicitly saved or saved on exit. To explicitly save an
activation:

1. Enable the set of watchpoints and breakpoints for the activation.

2. If the sample data set is to be included, run the Identify debugger to
collect the sample data.

3. Select File->Save activations or click the Save current activations icon in the
menu bar to bring up the following dialog box.
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@ Sawe current rigger settings as: |proto_2

¥ Save curment sample data

4. Enter (or select) an activation name in the Save current trigger settings as:
field. Selecting an existing activation from the drop-down menu
overwrites the selected activation.

5. To include the sample data set with the activation, enable the Save
current sample data check box.

6. Click Yes to save the activation.

Loading an Activation
To load an existing activation:
1. Open the project view.

2. Expand (if necessary) the hierarchy to display the list of activations as
shown in the following figure.

counker
£ verilog

counter_self. v
FE: inzt

£ activations
o] instr
@ case]
g case?

3. Click on the desired activation and select Load activation.
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Autosaving Current Activation

By default, when you exit the Identify debugger without explicitly saving an
activation, the active activation is automatically saved to the last_run.adb file.
This file is automatically loaded the next time you open the project.

Note: To save a specific activation, always use Save current activations to
explicitly name the file and prevent the data from overwriting the
last_run.adb file.

To disable the auto-save feature, uncheck the Auto-save trigger settings and
sample results check box on the Debugger Preferences dialog box (select
Options->Debugger preferences).

Cross Triggering

Cross triggering allows the trigger from one IICE unit to be used to qualify a
trigger on another IICE unit, even when the two IICE units are in different
time domains. Cross triggering is available in both the simple triggering and
complex counter triggering modes (state-machine triggering supports cross
triggering by allowing the IICE unit IDs to be included in the state-machine
equations).

Cross triggering for an IICE unit is enabled in the Identify instrumentor by
selecting the Allow cross-triggering in IICE check box on the IICE Controller tab for
the local IICE unit. The cross-trigger mode is selected from the drop-down
menu in the Identify debugger as shown below.

| =
]

Crozz brigger mode: Idiaabled F

dizabled
any o
L. (clk): al
after-ICE
after-all
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The drop-down menu selections are as follows:

Menu Selection Fynction

disabled No triggers accepted from external IICE units (event trigger can
only originate from local IICE unit)

any Event trigger from local IICE unit occurs when an event at any
IICE unit, including the local IICE unit, occurs

all Event trigger from local IICE unit occurs when all events,
irrespective of order, occur at all IICE units including the local
IICE unit

after-iiceName Event trigger from local IICE unit occurs only after the event at

selected external IICE unit iiceName has occurred (external IICE
units are individually listed)

after all Event trigger from local IICE unit occurs after all events occur
at all IICE units

Note: If the drop-down menu does not display, make sure that Allow
cross-triggering in lICE is enabled on the IICE Controller tab of the
Identify instrumentor and that you have defined more than one
IICE unit.
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Listing Watchpoints and Signals

To list categories of watchpoints and signals in the debugger, use the popup
Debug menu selection and select the category from the list displayed.

Identify Debugger - [C'J'dﬁ_ ns/bus E
File Edit lDehug Options  Window |

] Bun

Stop
Trigger Positior .. 4

Complex Co
Show digabled breakpoints

Show enabled breakpointz

Show all break

Show dizabled zignals
Show enabled zignals
Show all zsignals

LCocle ... 4

774 ldentify Debugger: Find Design Elemel

OF bype: Ibleakpoint

N armed: *
WWith status: I"
Lok, ir: |,.-'
InlICE: [nce

[ Show hidden elements Find | Cloze |

@ counter self.wv:61,11 falways_55/if 57/case 60/counter self.wv:61,11
@ counter self.v:65,10 falways_55/if 57/case_ &0/counter self.w:65,10
@ counter self.v:67,9 falways_55/if 57/case 60/counter self.v:67,9
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Show Watchpoint/Breakpoint Icons

The show watchpoint and breakpoint icons in the menu bar display their
corresponding values in the Find Design Elements dialog box as follows:

Show Disabled Breakpoints

To display the disabled (inactive) breakpoints, click the Show disabled
breakpoints icon.

Show Enabled Breakpoints

To display the enabled (active) breakpoints, click the Show enabled
@ breakpoints icon.

Show Disabled Watchpoints

To display the disabled (inactive) watchpoints, click the Show disabled

watchpoints icon.

Show Enabled Watchpoints

To display the enabled (active) watchpoints, click the Show enabled
g_ watchpoints icon.

Console Text

To capture all the text that is written to the console, use the log console
command (see the Reference Manual). Alternately, you can click the right
mouse button inside the console window and select Save Console Output from
the menu. To capture all commands executed in the console window, use the
transcript command (see the Reference Manual). To clear the text in the console
window, use the clear command or click the right mouse button inside the
console window and select clear from the menu.
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Waveform Display

The waveform display control displays the sampled data in a waveform style.
A selection of popular waveform viewers that support VCD data is included.
Alternately, you can interface your own waveform viewer by writing a custom-
ized script to access your waveform viewer from the Identify debugger.

Viewer selection and setup are controlled by the Waveform Viewer Preferences
dialog box. Selecting Options->Debugger preferences from the menu bar brings
up the dialog box shown below.

i B

Drefault ' aveform Wiswer

" Aldec Active-HDL

" Synopsys DVE

¢ GTKWwave

" Model Technology ModelSim

" Custom Procedure

cuzbom_wavelormiemer

o aveform Dizplay

Perind [nz): |2D j‘ Set Diefault

™ Show equivalent signals in wavefarm

¥ Show Identify cycle in wavefom

¥ Show sample clock in wavefom

Activation settings

¥ Auto-zave tigger settings and sample results

The default Synopsys DVE waveform viewer is only available on Linux
platforms. To use the included GTKWave viewer, which supports both the
Linux and Windows platforms, click the GTKWave radio button in the Default
Waveform Viewer section.

The Period field sets the period for the waveform display and is independent of
the design speed.
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—— After running the Identify debugger, the waveform viewer is displayed
EI by selecting Window->Waveform from the menu or by clicking the Open
Waveform Display icon in the menu bar. All sampled signals in the

design are included in the waveform display. Two additional signals are
automatically added to the top of the display. The first signal, identify_cycle,
reflects the trigger location in the sample buffer. The second signal,
identify_sampleclock, is a reference that shows every clock edge. The following
figure shows a typical waveform view with the identify_cycle and
identify_sampleclock signals highlighted.

Signals Waves
Time
identify cycle[321:0] =0

-1

identify sampleclock=1

current_state[3:0] =0001 0110 0003 {a[a]a]s]

If you select a waveform viewer from the Waveform preference dialog box that is
not installed, an error message is displayed when you attempt to invoke the
viewer. To install the waveform viewer:

1. Open the Debugger Preferences dialog box (select Options->Debugger
preferences).

2. Select the desired waveform viewer by clicking the adjacent radio button
and then click OK.

3. Make sure that the selected simulator is installed on your machine and
that the path to the executable is set by your $PATH environment
variable.

To invoke the viewer after running the Identify debugger, select
Window->Waveform or click on the Open Waveform Display icon.
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Debugging on a Different Machine

It is not unusual for the instrumentation phase and the debugging phase to
be performed on different machines. For example, the debug machine is often
located in a hardware lab. When a different machine is used for debugging,
you must copy both the project file (projectName.prj) and the Identify imple-
mentation directory (e.g., rev_1) to the lab machine.

Because the Identify tool set allows you to debug your design in the HDL, the
Identify debugger must have access to the original source files. Depending on
the type of your network, the Identify debugger may be able to access the
original sources files directly from the lab machine. If this is not possible or if
the two computers are not networked, you must also copy the original
sources to the debug machine. If the Identify debugger cannot locate the
original source files, it will open the project, but an error will be generated for
each missing file, and the corresponding source code will not be visible in the
source viewer.

Copying the source files to the debug machine can be done in two ways:

¢ Identify can automatically include the original source files in the imple-
mentation directory so that when you copy the implementation directory
to the lab machine, the original sources files (in the orig_sources subdi-
rectory) are included. The Identify debugger automatically looks in this
directory for any missing source files. This preference is set before
compiling the instrumented design by selecting Options->Instrumentation
preference and making sure that Save original source in instrumentation directory
is checked.

¢ The original source files can be manually copied to the lab machine or
may already exist in a different location on this machine. In this case, it
may be necessary to help Identify locate the design files using the search-
path command. Simply call this command from the command line before
loading the project file (projectName.prj). The argument is a semi-colon-
separated list of directories in which to find the original source files.

searchpath {d:/temp;c:/Documents and Settings/me/my design/}

The Identify debugger will only display files that match the CRC generated at
the time of instrumentation.
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Identify Debugger

Note: If there are security issues with having the original source files
on the lab machine, the Identify instrumentor can password-
protect the original sources on the development machine for use
with the Identify debugger (for information on file encryption, see
Including Original HDL Source, on page 73).

Simultaneous Debugging

When multiple Identify debugger licenses are available, multiple FPGAs
residing on a single, non-HAPS board can be debugged concurrently through
a single cable. This capability is based on semaphores that allow more than
one debugger to share the common port.

Debugger 1
pid1
PID1
Debugger 2
pid2
PID2

Semaphore

Cable

Identify Microsemi Edition User Guide
March 2015

Board

FPGA1 FPGA2
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SYNOPSys

CHAPTER 8

lICE Hardware Description

The Identify instrumentor adds instrumentation logic to your HDL design
that allows you to understand and debug the operation of your design. There
are some aspects of the instrumentation logic that are important to under-
stand in order to use the Identify tool set in the most effective way. In this
chapter, the overall instrumentation logic is described briefly followed by
descriptions of some of the more important features. A simplified functional
breakdown of the instrumentation logic consists of:

*» JTAG Communication Block

¢ Breakpoint and Watchpoint Blocks
* Sampling Block

e Complex Counter

e State Machine Triggering

JTAG Communication Block

The JTAG communication block can be implemented using either the built-in
device-specific TAP controller (the builtin option) or using the Identify imple-
mentation of the TAP controller (the soft option). See Chapter 9, Connecting to
the Target System, for more information on the JTAG controller.
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Breakpoint and Watchpoint Blocks

The following topic are described in this section:
¢ Breakpoints
¢ Watchpoints, on page 115
e Multiply Activated Breakpoints and Watchpoints, on page 115

Breakpoints

Breakpoints are a way to easily create a trigger that is determined by the flow
of control in the design.

In both Verilog and VHDL, the flow of control in a design is primarily deter-
mined by if, else, and case statements. The control state of these statements is
determined by their controlling HDL conditional expressions. Breakpoints
provide a simple way to trigger when the conditional expressions of one or
more if, else, or case statements have particular values.

The example below shows a VHDL code fragment and its associated break-

points.
89 process(op_code, cc, result) begin
100 case op code is
101 when "0100" =>
& 102 result <= part res;
103 if cc = '"1' then
& 104 c flag <= carry;
105 if result = zero then
& 106 z flag <= "1';
107 else
& 108 z_flag <= '0';
109 end if;
110 end if;

© 2015 Synopsys, Inc. Identify Microsemi Edition User Guide
114 March 2015



Breakpoint and Watchpoint Blocks IICE Hardware Description

The four breakpoints correspond to these control flow equations:
* Breakpoint at line number 102:
(op_code = "0100")
* Breakpoint at line number 104:
(op_code = "0100") and (cc = '1"')
* Breakpoint at line number 106:
(op_code = "0100") and (cc = 'l') and (result = zero)
* Breakpoint at line number 108:

(op_code = "0100") and (cc = 'l') and (result != zero)

Watchpoints

A watchpoint creates a trigger that is determined by the state of a signal in
the design. The watchpoint can trigger either on the value of a signal or on a
transition of a signal from one value to another.

Multiply Activated Breakpoints and Watchpoints

How breakpoints and watchpoints operate individually has been described
earlier in this guide. Activated breakpoints and watchpoints also interact with
each other in a very specific way.

Multiple Activated Breakpoints

Each breakpoint is implemented as logic that watches for a particular event
in the design. When an instrumented design has more than one activated
breakpoint, the breakpoint events are ORed together. This effectively allows
the breakpoints to operate independently — only one activated breakpoint
must trigger in order to cause the sampling buffer to acquire its sample.

Identify Microsemi Edition User Guide © 2015 Synopsys, Inc.
March 2015 115



IICE Hardware Description Sampling Block

Multiple Activated Watchpoints

Each watchpoint is implemented as logic that watches for a specific event
consisting of a bit pattern or transition on a specific set of signals. When an
instrumented design has more than one activated watchpoint, the watch-
point events are ANDed together. This effectively causes the watchpoints to
be dependent on each other — all activated watchpoint events must occur
concurrently to cause the sampling buffer to acquire its sample.

For example, if watchpoint 1 implements (count == 23) and watchpoint 2
implements (ack == ‘1’), then activating these watchpoints together effectively
creates a new watchpoint: (count == 23) && (ack == ‘1)).

Combining Activated Breakpoints and Activated Watchpoints

When an instrumented design has one or more activated breakpoints and
one or more activated watchpoints, the result of the OR of the breakpoint
events and the result of the AND of the watchpoint events is ANDed together.
The result of this AND operation is called the Master Trigger Signal. This
ANDing effectively causes the breakpoints and watchpoints to be dependent
on each other — one activated breakpoint and all activated watchpoint events
must occur concurrently to cause the sampling buffer to acquire its sample.

As a result, a Master Trigger Signal event can be constructed that operates
like a conditional breakpoint. For example, activating a breakpoint and the
two watchpoints from the previous example produces a conditional break-
point: (breakpoint event) &®& (count== 23) && (ack == ‘1’).

Sampling Block

The sampling block is basically a large memory used to store all the sampled
signals. During an active debugging session, the sampled signals are contin-
ually being stored in the sample block. When the sample block receives an
event from the Master Trigger Signal event logic or the complex counter logic,
the sampling block stops writing new data to the buffer and holds its
contents. Eventually, the contents of the sample block are uploaded to the
Identify debugger for display and formatting.

© 2015 Synopsys, Inc. Identify Microsemi Edition User Guide
116 March 2015



Complex Counter IICE Hardware Description

Whenever possible, the sample block should use the built-in RAM blocks that
are available in most programmable chips. Otherwise, implementing the
sample buffer using individual storage elements will consume large amounts
of the logic capacity of the chip. If you have no choice but to use individual
storage elements, analyze how much logic you have available on your chip
and adjust how many signals you sample and the depth of the sample buffer.

Complex Counter

The complex counter connects the output of the breakpoint and watchpoint
event logic to the sampling block and allows the user to implement complex
triggering behavior.

Creating a Complex Counter

The counter is created, configured, and inserted into the HDL design during
instrumentation using the Identify instrumentor IICE Controller tab of the IICE
Configuration dialog box or using the Identify instrumentor iice controller
command.

During configuration, the size of the counter is specified. For example, a 16-
bit counter is the default. This default value produces a counter that ranges
from O to 65535.

Setting the counter size to zero during instrumentation configuration
disables counter insertion.

Debugging with the Complex Counter

During debugging in the Identify debugger, the complex counter is used to
produce complex triggering behavior.

During the debugging of the design, the complex counter is set to zero on
invocation of the Identify debugger run command. Then, it counts events from
the Master Trigger Signal event logic in a specific way depending on the
counter mode.
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Finally, the counter sends a trigger event to the sample block when a termi-
nation condition occurs. The form of the termination condition depends on
the mode of operation of the counter and on the target value of the counter:

¢ The counter target value can be set to any value in the counter’s range.

¢ The counter has four modes: events, cycles, watchdog, and pulsewidth.

The counter target value and the counter mode can be set directly from the
main menu.

-
€ Identify Debugger - [C/designs/counter

File Edit Debug Options Window

=d 2o BHEE -
Complex Counter Mode: | events * Wl

Cycles
events
pulzeridib
watchdog

The following table provides a general description of the trigger behavior for
the various complex counter modes. Each mode is described in more detail in
individual subsections, and examples are included showing how the modes
are used. In both the table and subsection descriptions, the counter target
value setting is represented by the symbol n.

Counter mode Target value = 0 Target value n >0
events illegal stop sampling on the nth trigger
event.
cycles stop sampling on 1st stop sampling n cycles after the
trigger event 1st trigger event.
watchdog illegal stop sampling if the trigger

condition is not met for n
consecutive cycles.

pulsewidth illegal stop sampling the first time the
trigger condition is met for n
consecutive cycles.
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events Mode

In the events mode, the number of times the Master Trigger Signal logic
produces an event is counted. When the nth Master Trigger Signal event
occurs, the complex counter sends a trigger event to the sample block. For
example, this mode could be used to trigger on the 12278th time a collision
was detected in a bus arbiter.

cycles Mode

In the cycles mode, the complex counter sends a trigger event to the sample
block on the nth cycle after the first Master Trigger Signal event is received.
The clock cycles counted are from the clock defined for sampling. For
example, this mode could be used to observe the behavior of a design
2,000,000 cycles after it is reset.

watchdog Mode

In the watchdog mode, the counter sends a trigger event to the sample block
if no Master Trigger Signal events have been received for n cycles. For
example, if an event is expected to occur regularly, such as a memory refresh
cycle, this mode triggers when the expected event fails to occur.

pulsewidth Mode

In the pulsewidth mode, the complex counter sends a trigger event to the
sample block if the Master Trigger Signal logic has produced an event during
each of the most recent n consecutive cycles. For example, this mode can be
used to detect when a request signal is held high for more than n cycles
thereby detecting when the request has not been serviced within a specified
interval.

Disabling the Counter

According to the previous table, the counter can be disabled simply by setting
its target value to 1 and its mode to events. Then, the complex counter will
pass any received event from the Master Trigger Signal logic on to the sample
block with no additional delay.
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State Machine Triggering

This section describes the different methods of triggering available in the
Identify debugger. It explains the different choices available during instru-
mentation and the functionality these choices provide in the Identify
debugger as well as discussing the cost effects of the various types of instru-
mentation.

Simple or Advanced Triggering

There are two triggering modes available, the simple mode and the advanced
mode. The simple mode allows comparing signals to values (including don’t
cares) and then triggering when the signals match those values. This scheme
can be enhanced by using breakpoints to denote branches in control logic. If
a breakpoint is enabled, this particular branch must be active at the same
time that the signals match their respective values. The overall trigger logic
involves signals and breakpoints in the following way:

¢ Signals: All signals must match their respective comparison values in
order to trigger.

¢ Breakpoints: All breakpoints are OR connected, meaning that any one
enabled breakpoint is enough to trigger.

¢ Signals and breakpoints are combined using AND, such that all signals
must match their values AND at least one enabled breakpoint must
occur.

The logic that implements breakpoint and signal triggering is referred to as
trigger condition (condition) in the following text.

In the advanced trigger mode, multiple such trigger conditions are instru-
mented, and a runtime-programmable state machine is also instrumented to
allow you to specify the temporal and logical behavior that combines these
trigger conditions into a complex trigger function. For instance, this state
machine enables you to trigger on a certain sequence of events like “trigger if
pattern A occurs exactly five cycles after pattern B, but only if pattern C does
not intervene.”

By default, the Identify instrumentor instruments the design according to the
simple trigger mode. See the following for more information on how to select
the advanced trigger mode.
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Advanced Triggering Mode

Setting up an instrumented design to enable advanced triggering is extremely
easy. There are two iice controller command options available in the Identify
instrumentor that control the extent and cost of the instrumentation:

» -triggerconditions infeger — The integer argument to this option defines
how many trigger conditions are created. The range is from 1 to 16. All
these trigger conditions are identical in terms of signals and breakpoints
connected to them, but they can be programmed separately in the
Identify debugger.

» -triggerstates integer — The integer argument to this option defines how
many states the trigger state machine will have. The range is 2 to 16;
powers of 2 are preferable as other numbers limit functionality and do
not provide any cost savings.

Similar to the simple-triggering mode, a counter can be instrumented to
augment the functionality of the state machine. To instrument a counter,
enter an iice controller -counterwidth option with an argument greater than O in
the Identify instrumentor console window.

Please refer to the following text to determine cost and consequences of these
settings in the Identify instrumentor.

Structural Implementation of State Machine Triggering

For each trigger condition c;, a logic cone is implemented which evaluates the
signals and the breakpoints connected to the trigger logic and culminates in a
1-bit result identical to the trigger condition in simple mode. All these 1-bit
results are connected to the address inputs of a RAM table.

If a counter has been added to the instrumentation, the counter output is
compared to constant O, and the single-bit output of that comparison is also
connected to the address inputs of the same RAM table.

The other address inputs are provided by the state register.
The outputs of the RAM table are:

¢ the next-state value nstate

* the trigger signal trigger (causes the sample buffer to take a snapshot if
high)

* the counter-enable signal cnten (if ‘1’°, counter is decremented by 1)
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¢ the counter-load signal cntld (if ‘1’, counter is loaded with cntval)

* the counter value cntval (only useful in conjunction with cntld)

The last three outputs are only present if a counter is instrumented. Please
also refer to the figure below.

State
—— nstate g’
, 2-port RAM N cnild [T
cnten__ -'g

tnull
port 1, read-only | carval | 3| <"
1 o
o .
trigger -~

port 2, write-only

Write port driven by JTAG circuitry

The implementation of the RAM table is identical to the implementation of the
sample buffer (that is, the device buffertype setting selects the implementation
of both the sample buffer and the state-machine RAM table).

Cost Estimation

The most critical setting with respect to cost is the number of trigger condi-
tions, as each trigger condition results in an additional address bit on the
RAM, and thus doubles the size of the RAM table with each bit. Next in
importance is the counter width as this factor contributes directly to RAM
table width and is especially significant in the context of FPGA RAM primi-
tives that allow a trade-off of width for depth.
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The actual instrumentation, however, is not limited to the use of a single
block RAM (for example, it may be advantageous in a particular situation to
trade away states for additional trigger conditions or for additional counter
width). Any configuration can be automatically implemented, as long as it fits
on the device with the rest of the design.

Although RAM parameters are automatically determined by the Identify
instrumentor, this information should be monitored to make sure that no
resources are wasted.

Using State Machine Triggering in the Identify Debugger

Perform the following steps in the Identify debugger console window to setup
a trigger in advanced triggering mode. These steps can be done in any order.

* setup the values for the trigger conditions using the Identify debugger
watch and stop commands.

* setup the trigger state machine behavior using the Identify debugger
statemachine command.

The watch command takes an additional parameter, -condition, specifying the
trigger conditions that the given condition is intended for. This argument is
available in simple mode as well, but as there is only one trigger condition in
this case, the argument is redundant.

» watch enable -condition (friggerCondition|all) signalName value1 [value2 ...]
« watch disable -condition (triggerCondition|all) signalName

« watch info [-raw] sighalName

The parameter triggerCondition is a list value conforming to the Tcl language.
Examples are: 1, "1 2 3", {2 3}, or [1ist 1 2 3], quotes, braces, and
brackets included, respectively. Alternatively, the keyword all can be specified
to apply the setting to all trigger conditions.

The Identify debugger watch info command reports status information about
the signal. This information is returned in machine-processible form if the
optional parameter -raw is specified.

Similarly for the Identify debugger stop command:
» stop enable -condition (triggerCondition|all) breakpoint
+ stop disable -condition (triggerCondition|all) breakpoint
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» stop info [-raw] breakpoint

The semantics of the parameters are identical to the above descriptions.

The statemachine Command

During instrumentation, the number of states was previously defined using
the -triggerstates option of the Identify instrumentor iice controller command.
Now, at debug time, you can define what happens in each state and transi-
tion depending on the pattern matches computed by the trigger conditions.
The Identify debugger statemachine command is used to configure the trigger
state machine with the desired behavior. This is very similar to the
“advanced” trigger mode offered by many logic analyzers. As it is very easy to
introduce errors in the process of specifying the state machine, special
caution is appropriate. Also, a state-machine editor is available in the Identify
debugger user interface to facilitate state-machine development and under-
standing (see State-Machine Editor, on page 130). It is also important to note
that the initial state for each run is always state O and that not all of the
available states need to be defined.

The syntax forms of the Identify debugger statemachine command are:

¢ statemachine addtrans -from state [-to state] [-cond "equation|titriggerinID"]
[-entval integer] [-cnten] [-trigger]

e statemachine clear (-all|state [state ...])

» statemachine info [-raw] (-all|state [state ...])

Subcommand statemachine addtrans

The Identify debugger addtrans subcommand defines the transitions between
the states. The options are as follows:

e -from state — specifies the state this transition is exiting from.

* -to state — specifies the state this transition goes to. If this is not given, it
defaults to the state given in the -from option.

e -cond "equation|titriggerinID"™ — specifies the condition or external trigger
input under which the transition is to be taken. The default is “true”
(i.e., the transition is taken regardless of input data; see below for more
details).
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-cntval integer — specifies that if this transition is taken, the counter is
loaded with the given value. Only valid when a counter is instrumented.

-cnten — when this flag is given, the counter is decremented by 1 during
this transition. Only valid when a counter is instrumented.

-trigger — when this flag is given, a trigger occurs during this transition.

The order in which the transitions are added is important. In each state, the
first transition condition that matches the current data is taken and any
subsequent transitions in the list that match the current data are ignored.

Conditions

The conditions are specified using Boolean expressions comprised of
variables and operators. The available variables are:

Oper

c0, ... cn, where nis the number of trigger conditions instrumented.
These variables represent the output bit of the respective trigger condi-
tion.

titriggerinlD — the ID (O thru 7) of an external trigger input.

cntnull — true whenever the counter is equal to O (only available when a
counter is instrumented).

iicelD — variable used with cross triggering to define the source IICE units
to be included in the equation for the destination IICE trigger.

ators are:

Negation: not, !, ~

AND operators: and, &&, &
OR operators: or, ||, |
XOR operators: xor, *

NOR operators: nor, ~|
NAND operators: nand, ~&
XNOR operators: xnor, ~*
Equivalence operators: ==, =

Constants: 0, false, OFF, 1, true, ON
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Parentheses ‘ (¢, ‘)’ are recommended whenever the operator precedence is in
question. Use the Identify debugger statemachine info command to verify the
conditions specified. For example, valid expression examples are:

"cO0 and cl1"
"l (cl or c2) and c3"

"cO or ti4" (condition cO or external trigger ID ti4)

Other Subcommands

The Identify debugger statemachine clear command deletes all transitions from
the states given in the argument, or from all states if the argument -all is
specified.

The Identify debugger statemachine info command prints the current state
machine settings for the states given in the argument, or for the entire state
machine, if the option -all is specified. If the option -raw is given, the informa-
tion is returned in a machine-processible form.

State Machine Examples

To implement a trigger behavior that triggers when the pattern on condition 1
or condition 2 (c1 or ¢2) becomes true for the 10th time (a setting identical to
counter mode events in the simple mode triggering), the following state
machine can be used:

statemachine addtrans -from 0 -to 1 -cntval 9
statemachine addtrans -from 1 -cond " (cl | c2) & cntnull" -trigger
statemachine addtrans -from 1 -cond "cl or c2" -cnten

A trigger condition requiring pattern c2 to occur 10 times after pattern ¢1 has
occurred, without pattern ¢3 occurring in between (commonly available in
logic analyzers as “Pattern 1 followed by Pattern 2 before Pattern 3”) can be
achieved with the following state machine:

statemachine addtrans -from 0 -to 1 -cond cl -cntval 9
statemachine addtrans -from 1 -cond "c2 & cntnull" -trigger
statemachine addtrans -from 1 -to 0 -cond c3

statemachine addtrans -from 1 -cond "c2" -cnten

These behaviors can be cascaded by moving on to the next behavior instead
of triggering in the transition that has -trigger specified, as long as there are
trigger conditions and states available.
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Convenience Functions

There are a number of convenience functions to set up complex triggers avail-
able in the file identifylnstallDir/share/contrib/syn_trigger_utils.tcl which is loaded into
the Identify debugger at startup:

st_events condition integer — Sets up the state machine to mimic counter
mode events of the simple triggering mode as described above. The
argument condition is a boolean equation setting up the condition, and
integer is the counter value.

st_watchdog condition integer — Same as st_events for watchdog mode.
st_cycles condition integer — Same as above for cycles mode.
st_pulsewidth condition integer — Same as above for pulsewidth mode.

st_B_after_A conditionA conditionB [integer:=1] — Sets up a trigger mode to
trigger if conditionB becomes true anytime after conditionA became true.
The optional integer argument defaults to 1 and denotes how many
times conditionB must become true in order to trigger.

st_B_after_A_before_C conditionA conditionB conditionC [integer:=1] — Sets up a
trigger mode to trigger if conditionB becomes true after conditionA
becomes true, but without an intervening conditionC becoming true
(same as the second example above). The optional integer argument
defaults to 1 and denotes how many times conditionB must become true
without seeing conditionC in order to trigger.

st_snapshot_fill condition [integer] — Uses qualified sampling to sample data
until sample buffer is full. The argument condition is a boolean equation
defining the trigger condition, and integer is the number of samples to
take with each occurrence of the trigger (default 1).

st_snapshot_intr condition [integer] — Uses qualified sampling to sample data
until manually interrupted by an Identify debugger stop command. The
argument condition is a boolean equation defining the trigger condition
and integer is the number of samples to take with each occurrence of the
trigger (default 1).

Please refer to the file syn_trigger_utils.tcl mentioned above for the implementa-
tion of these trigger modes using the Identify debugger statemachine command.
Users can add their own convenience functions by following the examples in
this file.
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Cross Triggering with State Machines

Cross triggering allows a specific IICE unit to be triggered by one or more IICE
units in combination with its own internal trigger conditions. The IICE being
triggered is referred to as the “destination” IICE; the other IICE units are
referred to as the “source” IICE units.

Multiple IICE designs allow triggering and sampling of signals from different
clock domains. With an asynchronous design, a separate IICE unit can be
assigned to each clock domain, triggers can be set on signals within each
IICE unit, and then the IICE units scheduled to trigger each other on a user-
defined sequence using cross triggering. In this configuration, each IICE unit
is independent and can have unique IICE parameter settings including
sample depth, sample/trigger options, and sample clock and clock edges.

Cross triggering is supported in all three IICE controller configurations
(simple, complex counter, and state-machine triggering) and all three config-
urations make use of state machines.

Cross triggering is enabled in the Identify instrumentor (cross triggering can
be selectively disabled in the Identify debugger). To enable a destination IICE
unit to accept a trigger from a source IICE unit, enter the following command
in the Identify instrumentor console window (by default, cross triggering is
disabled):

iice controller -crosstrigger 1

For cross triggering to function correctly, the destination and the contributing
source IICE units must be instrumented by selecting breakpoints and watch-
points. Concurrently run these units either by selecting the individual I[ICE
units and clicking the RUN button in the Identify debugger project view or by
entering one of the following commands in the Identify debugger console
window:

run -iice all
run -iice {iiceIDl1 iiceID2 ... iiceIDn}

When simple- or complex-counter triggering is selected in the destination
IICE controller, the following Identify debugger cross-trigger commands are
available:

¢ The following Identify debugger command causes the destination IICE to
trigger normally (the triggers from source IICE units are ignored).

iice controller -crosstriggermode DISABLED
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* The following Identify debugger command causes the destination IICE to
trigger when any source IICE triggers or on its own internal trigger.

iice controller -crosstriggermode ANY

* The following Identify debugger command causes the destination IICE to
trigger when all source IICE units and the destination IICE unit have
triggered in any order.

iice controller -crosstriggermode ALL

* The following Identify debugger commands cause the destination IICE to
trigger after the source IICE unit triggers coincident with the next desti-
nation IICE internal trigger.

iice controller -crosstriggermode after -crosstriggeriice iiceID
iice controller -crosstriggermode after -crosstriggeriice all

The first Identify debugger command uses a single source IICE unit
(ticelD), and the second Identify debugger command requires all source
IICE units to trigger.

When state-machine triggering is selected, the state machine must be speci-
fied with at least three states (three states are required for certain triggering
conditions, for example, when the destination IICE is in Cycles mode and you
want to configure the destination IICE to trigger after another (source) IICE.

With state-machine triggering, the following Identify debugger statemachine
command sequences are available in the Identify debugger console window:

* The following Identify debugger command sequence is equivalent to
disabling cross triggering. The destination IICE triggers on its own
internal trigger condition (cO).

statemachine clear -all
statemachine addtrans -from 0 -cond "cO" -trigger

* In the following Identify debugger command sequence, the destination
IICE waits for iicelD to trigger and then triggers on its own internal
trigger condition (cO). This sequence implements the “after iiceID”
functionality of the simple- and complex-counter triggering modes.

statemachine clear -all
statemachine addtrans -from 0 -to 1 -cond "iiceID"
statemachine addtrans -from 1 -to 0 -cond "cO" -trigger
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¢ In the following Identify debugger command sequence, the destination
IICE triggers when the last running IICE triggers.

statemachine clear -all

statemachine addtrans -from 0 -cond "cO and iiceID and iiceID1
and iiceID2" -trigger

statemachine addtrans -from 0 -to 1 -cond "cO"

statemachine addtrans -from 1 -to 0 -cond "iiceID and iiceID1
and iiceID2" -trigger

¢ In the following Identify debugger command sequence, the destination
[ICE waits for all the other running source IICE units to trigger and then
triggers on its own internal trigger condition (cO).

statemachine clear -all

statemachine addtrans -from 0 -to 1 -cond "iiceID and iiceID1
and iiceID2"

statemachine addtrans -from 1 -cond "cO0" -trigger"

The incorporation of a counter in the state-machine configuration is similar
to the use of a counter in non-cross trigger mode for a state machine.

State-Machine Editor

The Identify debugger includes a graphical state-machine editor that is avail-
able when state-machine triggering is enabled for the active IICE unit on the
IICE Controller tab in the Identify instrumentor.

To bring up the state-machine editor in the Identify debugger, click
ﬁ_ the Configure Statemachine Trigger icon in the Identify debugger toolbar.
Note that the icon will be grayed out if state-machine triggering was
not enabled in the Identify instrumentor when the design was instrumented
and that an error message will be generated if more than 10 states are
defined. Clicking the icon displays the Statemachine Editor dialog box for the
selected IICE.
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4 Statemachine Editor for ICE TICE'

. ‘ &2 | Inzert Macro:

— State 0
I A & e
— State 1

I [O]@ [c1 and crtrll)
— State 2

ak I Cahicel

Each state is defined in an individual entry field. Within each entry, you can
add multiple definitions for transitioning from that state. Each transition
includes either one or two actions and a condition. The actions and condi-
tions are defined in the following tables.

Action Description
Decrement Counter Decrements counter when condition is true
El (mutually exclusive with Initialize Counter)
Initialize Counter Initializes counter to count specified by

statemachine transition editor (mutually exclusive
with Decrement Counter)

Trigger Sample Buffer ~ Triggers sample buffer when condition is true

Go to State Transitions to specified state when condition is true

<+
T
[2]
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Condition

cO..cN

cntnull

iicelD

titriggerinlD

Boolean

Description

References trigger event in active IICE unit

True when counter is equal to O (available only when counter is
instrumented)

References trigger event from a second IICE unit for cross
triggering (cross triggering must have been enabled when the
design was instrumented)

References external trigger originating from an IICE module in
another FPGA or on-board external logic

Boolean operators used to define state-machine events (see
Conditions, on page 125)

To use the dialog box:

e As an optional starting point, use Insert Macro to select predefined state-
machine behaviors from the drop-down list. When a macro is selected, a
corresponding Configure Statemachine Macro dialog box is displayed to set
the parameters for the macro. The following figure shows the dialog box
for the st B_after A macro.

%% Configure Statemachine Macro &J

st_B_after_A

Thiz macro configures the statemaching to mimic
a logic analwzer trigger. It tiggers the samplebuffer
when event 'B' happens M times after event ‘A

QCCurs,

Cancel

Enter the required parameters into the dialog box. These parameters
include events, Boolean functions, transition count, and IICE unit. Click
OK after all of the parameters are entered.
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e Use the Add new transition, Edit current transition, and Delete current transition
icons as required. The Add new transition and Edit current transition icons
bring up the Statemachine transition editor dialog box which allows transi-
tions to be defined or redefined.

& Statemachine transition editor . ﬂ

Tranzition From State: |0 3] ToState: |0 %I

Ot Condition:

Available Identifiers: =0 21 c2 £3 cntnull

Actions:

@ | Trigger the sample buffer

) [ Decrement the counter

&L [ Initislize the counter to:

Cancel

Click OK when the transition has been defined/redefined.

¢ Click OK in the initial Statemachine Editor dialog box when the state-
machine triggering condition has been defined.

Note that you can view the corresponding state-machine commands in the
Identify debugger console window using the statemachine info -all command.

C o tool=ssident211_078RE-bin$ statemachine info —-all
State 0
if "c0" goto 1 —cntwval 4
State 1.
if "({cl and cntnull)” goto 0 —trigger
if "cl" goto 1 —cnten
State 2:
State 3.

C. tools ident2ll_078R-bins
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State-Machine Examples

The Identify state-machine triggering feature allows the creation of counter-
based state machines from sequences of trigger conditions to create very
effective triggers. You can set up a state-machine trigger during instrumenta-
tion and then program the state machine dynamically during debug to create
a complex, design-specific trigger.

Building a Complex State-machine Trigger

When building a complex, state-machine trigger, you specify the number of
trigger states, the trigger conditions (which can be set dynamically in the
Identify debugger), and the counter width. A common design configuration is
to trigger when a specific sequence of events occurs which, in turn, causes
data collection to stop and the sample data to be downloaded by the corre-
sponding Identify debugger executable from the FPGA. You can enable state-
machine triggering and specify the states through the user interface as
outlined in the following steps:

1. In the Identify instrumentor graphical user interface, select
Actions->Configure IICE from the top menu bar or click the IICE icon.

2. From the Identify instrumentor Configure IICE dialog box, select the IICE
Controller tab, click the State Machine triggering radio button, and specify the
number of trigger states, trigger conditions, and the counter width in the
corresponding fields.

i B
¢ Identify Instrumentor: Configure ICE 'IC ==

IICE Sampler  IICE Cantroller |

Current [ICE:  |IICE j IICE type:  |regular
IICE Contraller

" Simple tiggering

" Complex counter tiggering

width G

Ly

* State Machine tiggering

Trigger states: |4 ﬁ
Trigger conditions: |4 2
Counter width: [1E 2
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3. Build the state machine trigger from the Identify debugger console

window. The following Identify debugger command sequence is an
example.

statemachine addtrans -from 0 -to 1 -cond cO -cntval 7 -trigger
statemachine addtrans -from 1 -to 0 -cond "cntnull"
statemachine addtrans -from 1 -to 1 -cnten -trigger

Note that in the last Identify debugger statemachine command, the -to 1
can be omitted (unnecessary because there is no change in state) and
that because the -from states are the same in the second and third
commands, execution falls through to the third command when the
second condition is not true.

. Once the state-machine trigger is created, use the Identify debugger
statemachine info -all command to display and review the state-machine

transitions.

The state-machine editor in the Identify debugger GUI can be used to define
the state-machine trigger event described in step 3 as shown in the following

figure.

load counter

] StatemachmE/E/d|tor for ICE TICE'

D A‘; &7 | Inzert Macro
State 0
,T. 4o
State 1
‘ [ cntnull <e— transition on counter = 0
@5 e
count

trigger when counter = 0
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.—» load counter

transition transmon
count=0 cO =1
trigger
@ count=0
count>0
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The following figure shows the state-machine transition editor (click the Add

new transition icon).

74 Statemachine Editor for ICE TICE'

O

State 0

! ! ¥ ——
——— -
74 Statemachine transition editor i @

Trangition From State: |1 ;I To State: |1 ;I

On Condition; |true

c3

cntnull

State 2 .
ate Actiohs:

@ [ Trigger the sample buffer

State 3
E W Decrement the courter

£ [ Initislize the counter ta:

ak. | Cancel

The Identify debugger state-machine and state-machine transition editors

allow:

* Graphical entry of state machines

e Editing of state transitions and trigger events

¢ Conditions to be combined with each other or with a counter

¢ Counter mode selection of up, down, or initialized to any value

State-machine Triggering with Tcl Commands

The IICE can be configured using TCL commands entered from both the
Identify instrumentor and Identify debugger console windows. Some of the

example commands are as follows:

* To delete the state transitions from each IICE, use the following Identify

debugger command:

statemachine clear -iice all
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* To enable complex counter triggering, use the following Identify instru-
mentor command:

iice controller complex

* To set the counter width, use the following Identify instrumentor
command:

iice controller -counterwidth 8

* To configure an IICE for state-machine triggering, use the following
Identify instrumentor command sequence:

iice controller -iice IICE statemachine

iice controller -iice IICE -counterwidth 4
iice controller -iice IICE -triggerconditions 2
iice controller -iice IICE -triggerstates 2

In addition to state-machine triggering, the above Identify instrumentor
commands set the number of trigger conditions to 2 and the number of
trigger states to 2.

* To enable cross triggering, use the following Identify instrumentor
command:

iice controller -crosstrigger 1

* Similarly, to configure the sample depth, use the following Identify
instrumentor command:

iice sampler -depth 2048

Note that the only option for buffer type is internal_memory.

Qualified Sampling

During qualified sampling, data is sampled on every clock. The following
example uses qualified sampling to examine the data for a given number of
clock cycles. To create a complex trigger event to perform qualified sampling:

1. From the Configure IICE dialog box in the Identify instrumentor GUI,
select the IICE Controller tab, click the State Machine triggering radio button,
and enter a value in the Counter width field to define the width of the
sample buffer.

2. Select the [ICE Sampler tab and enable the Allow qualified sampling check
box.
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3. From the Identify debugger GUI, select qualified_fill from the Sample Mode
drop-down menu.

] sample Mode: [quaified_fil |+

normal

qualified Fill =
qualified_intr

4. From the Identify debugger GUI, click on the adjacent Configure
Statemachine Trigger icon and define the state-machine trigger event.

5. From the Identify debugger GUI, select the st_snapshot_fill macro from the
Insert Macro drop-down menu.

Statemachine Edi |
5 £ | Inzert Macro: Isl_snapshot_fill j

— Configure Statemachine Macro Elm

zt_znapszhat_fill

l— Thiz macro configures the statemaching to create a
complex tigger using 'gualified sampling’. It tiggers the

— Glate2 zamplebuffer to take N samples each time condition
' ocourz, The zampling stops when the samplebuffer

haz been filed.

—State 3———— =

l— A:l L

N:l

Ok I Cancel —

Enter the trigger event (the condition that will be the qualifying trigger)
in field A, enter the number of samples to be accumulated in the sample
buffer after the trigger event occurs in field N, and click OK to update the
state-machine definition.

When you click Run in the Identify debugger project window, the sample
buffer begins accumulating data when the trigger event occurs and stops
accumulating data after the specified number of samples is reached.
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Note: If you use the Identify debugger st_snapshot_intr macro in place of
the st_snapshot_fill macro, the sample buffer is continually over-
written until manually interrupted by a stop command.

You can also perform qualified sampling using equivalent Identify debugger
Tcl commands. The following Identify debugger example command sequence
samples the data every N cycles beginning with the first trigger event.

iice sampler -samplemode qualified fill

statemachine clear -iice IICE -all

statemachine addtrans -iice IICE -from 0 -to 1
-cond "true" -cntval O

statemachine addtrans -iice IICE -from 1 -to 2
-cond "cO" -cntval 15 -trigger

statemachine addtrans -iice IICE -from 2 -to 2
-cond "! cntnull" -cnten

statemachine addtrans -iice IICE -from 2 -to 2
-cond "cntnull" -cntval 15 -trigger

Remote Triggering

Remote triggering allows one debugger executable to send a software trigger
event to terminate data collection in the other debugger executables, effec-
tively creating a remote stop button.

You can selectively set the remote trigger to:
* trigger all [ICEs in all debugger executables
* trigger all [ICEs in a specific debugger executable

» trigger a specific IICE in a specific debugger executable

A common design configuration is to trigger all FPGAs on a single board-level
event; when that event occurs, data collection is stopped and the sample data
is downloaded by the corresponding debugger executables for all FPGAs.

Remote triggering is a scripting application. The IICE/debugger targets are
defined by the Identify debugger remote_trigger command (see the command
description in the Reference Manual).

Identify Microsemi Edition User Guide © 2015 Synopsys, Inc.
March 2015 139



IICE Hardware Description State Machine Triggering

As an example, the Identify debugger scripting sequence
run ; remote trigger -pid 12

walits for the trigger condition in the active IICE and then sends a trigger to all
IICE units in the debugger executable identified by process ID 12.

Importing External Triggers

An import external trigger capability can be used with trigger signals origi-
nating from on-board logic external to the FPGA or from an IICE module in a
second FPGA.
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Innova

CHAPTER 9

Connecting to the Target System

This chapter describes methods to connect the Identify debugger to the target
hardware system. The programmable device or devices in the target system
that contain the design to be debugged are usually placed on a printed circuit
board along with a number of other support devices. The difficulty is that the
boards differ greatly in the connections between their programmable devices,
the other components, and the external connections of the boards.

This chapter outlines how to connect the Identify debugger to most of the
common board configurations and addresses the following topics:

* Basic Communication Connection

* JTAG Communication

* JTAG Hardware in Instrumented Designs
* Using the Built-in JTAG Port

e Using the Synopsys Debug Port

* JTAG Communication Debugging
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Basic Communication Connection

The components that make up the debugging system are:
¢ The host machine running the Identify tool set with a loaded project.

¢ The communication cable connecting the host machine to the program-
mable device.

¢ The programmable device or devices loaded with the instrumented
version of the design to be debugged.

Identify Debugger Communications Settings

Identify debugger communications settings are defined on the project window
and include selecting the cable type and setting the port parameters for the
selected cable.

Cable Type

The cable type is selected from a drop-down menu in the Communications
settings area of the Identify debugger project window (see following figure).

Communication settings

Cable type: | Microsemi_Builin TAG e

Fort settingz ... | Shova chain ... |

Conm check. ..

The Microsemi_BuiltindTAG cable type supports the Microsemi flashPro, flashP-
roLite, and flashPro3 cables. To configure any of these cables, simply select
the Microsemi_BuiltindTAG setting from the Cable type drop-down menu. If you
are using the command interface, you can additionally use the com
command’s cableoptions option to set the tri-state pin parameter (see the com
command cableoptions option in the Reference Manual for the parameter
syntax).

Demo Cable Settings

The Port Settings button is disabled when the demo cable is selected.
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Identify Debugger Configuration

All parts of the debugging system must be configured correctly to make a
successful connection between the Identify debugger and the instrumented
device or devices through the cable. In addition to selecting the cable type
and port parameters described in Identify Debugger Communications
Settings, on page 142, the following additional requirements must be met to
ensure proper communications.

JTAG Client-Server Configuration

The client-server configuration is set from a dialog box available by selecting
Options->Configure JTAG server in the Identify debugger. The default settings are
usually correct for most configurations and require changing only when the
default server port address is already in use or when the Identify debugger is
being run from a machine that is not the same machine connected to the
FPGA board/device (see Client-Server Configuration for Remote Debugging,
on page 144).

Cable type
|Microsemi_BuiItinJT.-’-‘«G ﬂ W Usze client/server

zemver addrezs [127.0.0.17
[127.0.01

client/zerver port (580157
58015

client/zerver logfile [ipo_tep_microzemi.log')

|ipc_tcp_micrnsemi.lng
Start/Stop

Skart server Connection starts for Microsemi EuiltinJTAG.
Stop gemver
Update log

In the dialog box:

Cable type — the type of interface cable. The only available type for
Microsemi devices is Microsemi_BuiltindTAG.
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server address — the address of the server. The address localhost is used
when the Identify debugger is run on the same machine connected to
the FPGA device. The server address is set to the IP address of the
machine connected to the FPGA device/board when the Identify
debugger is run from a different machine.

client/server port — the port number of the server. For Microsemi cable
types, the default port number is 58015. Change the server port setting
when there is a conflict with another tool on the machine.

client/server logfile — the name of the log file.

Start/Stop — server control buttons for starting and stopping the JTAG
server. The Update log button adds a start/stop entry to the log file.

Client-Server Configuration for Remote Debugging

The Identify debugger uses a client-server architecture to communicate with
FPGAs over the JTAG interface. Client-server architecture lets you work
remotely with the Identify debugger using Ethernet as the backbone for
client-server communication. The Identify debugger can be configured in
either the client or server mode.

In the client-server architecture, the machine connected to the target FPGA
board is termed the server and any machine on the same network that is
used to launch the Identify debugger and connect to the server is termed the
client. You can use the Configure client/server settings dialog box described in the
previous section to set the IP address or the host name of the server so that
you can remotely debug the design. You can also specify the port for client-
server communication. Client-server communication uses the TCP/IP
communication protocol.

Client-Server Configuration

To establish a client-server connection:
1. Configure the target FPGA with the design to be debugged.

2. Start the server on the machine connected to the target FPGA board,
launch the debugger, and then configure the server-side debugger as
described below:

— Load the project file (design) to be debugged.
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— In the debugger Ul, select Configure client/server from the Options drop-
down menu.

— Specify the server address, port number, and log file name in the
Configure client/server settings dialog box. The server address can be
either the name of the host machine or its IP address. If you do not
know the hostname or IP address, set it to localhost. Set the
client/server port according to the selected cable type (58015).
Configuring the client-server parameters does not start the server.

— To start the server, select the Start server button in the dialog box.
Alternatively, you can run the com check command by selecting the
Comm check button in the debugger project view. If the server starts
successfully, you see the jtag process running in the task manager. If
the server cannot be started on the host machine, an error message is
displayed.

3. To debug the design from a remote machine (client), launch the
debugger on the client machine and load the project to be debugged.
Then configure the client-side debugger as described below:

— In the debugger Ul, select Configure client/server from the Options drop-
down menu.

— Specify the server address, port number, and log file name in the
Configure client/server settings dialog box. The server address can be
either the name of the host machine or its IP address. The port
number must be the same as the port number used to configure the
server.

The following is the syntax for the equivalent TCL command to configure the
JTAG server:

jtag_server set -addr {hostName/IP_address} -port {serverPort} -logf {logFfileName}

To view the existing JTAG server configuration settings, use the jtag_server get
Tcl command.

Check the client-server communication by running the com check command
by selecting the Comm check button in the debugger project view. If the client-
server communication cannot be established, an error message is displayed
in the debugger.

Once the client-server communication is running properly, you can debug
the design remotely.
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Parallel/USB Port Drivers

The parallel port or USB driver must be installed and operating (see the
installation procedures in the release notes). Make sure the host machine on
which you are running the Identify debugger has the parallel port or USB
driver installed.

Communication Cable Connections

The communication cable must be connected correctly. There are two
connections:

¢ Cable-to-host — make sure that the parallel port you connect the cable to
corresponds to the Ipt specified using the com port command.

The Identify debugger uses the “standard” I/O port definitions: Ipt1:
0x378-0x37B, Ipt2: 0x278-0x27B, Ipt3: 0x3BC-0x3BF, and Ipt4: 0x288-
0x28B if it cannot determine the proper definitions from the operating
system. If the hardware address for your parallel port does not match
the addresses for Iptl through Ipt4, you can use the setsys set command
variable Ipt_address to set the hardware port address (for example, setsys
set Ipt_address 0x0378 defines port Ipt1).

¢ Cable-to-board — the cable must be connected correctly to the board that
contains the programmable device or devices to be debugged. When you
instrumented your design, you selected a JTAG connection to use:
builtin or soft (Synopsys debug port). If you selected the builtin option,
connect the cable to the same leads that you use for the JTAG based
programming of the chip. If you selected the soft option, four JTAG
signals were added to the top level of your design. You must assign these
signals to pins on the chip that are connected to accessible probe points
on your board. Once this is complete, connect the four JTAG signals to
the proper probe points, and make sure that you also connect the power
and ground leads.

JTAG Chain Description

If you are using the builtin JTAG connection and the device to be debugged is
part of a multi-device scan chain, the Identify debugger first attempts to
detect the devices in the scan chain. If auto-detection is unsuccessful,
describe the device chain to the Identify debugger using the chain command.
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Chip Programming

Make sure that you program the device with the instrumented version of your
design, NOT the original version.

JTAG Communication

JTAG is a 4-wire communication protocol defined by the IEEE 1149.1
standard. The JTAG standard defines the names of the four connections as:
TCK, TMS, TDI, and TDO.

The JTAG-compliant devices can be connected to a host computer through a
JTAG cable. Such devices can be connected directly to the cable (see following
figure), or multiple devices can be connected in a serial chain as shown in the
figure on the following page.

LU UL ELLLLLLLLLLLLLL

LLLLLLLLLLLLLLLLL

TCK gl

JTAG | ™ms|— @ TAP .=
O —» trol

Cable TDO | -—= Contro |

LLLLLLLLLLLELLLLLL

LR RN RN AR RN AR RN RRR RN

Notice in the second figure that the TCK and TMS connections are connected
directly to both devices while the TDI and TDO connections route from one
device to the other and loop back to the JTAG cable.
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TCK >

JTAG | T™s L

Cable | TDI EoTRt
TDO
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JTAG Hardware in Instrumented Designs

The Identify tool set uses a JTAG connection to communicate with the instru-
mented design. To do this, the [ICE must contain a TAP controller that imple-
ments the JTAG standard. The IICE JTAG connection currently can be imple-
mented in one of two ways:

e The IICE can be configured (using the builtin option) to use the JTAG
controller that is built into the programmable chip. This approach has
the advantage that the built-in TAP controller already has hard-wired
connections and four dedicated pins. Accordingly, employing the
Identify tool set does not cost extra pins. In addition, the built-in TAP
controller does not require any user logic resources because it usually is
implemented in hard-wired logic on the chip. Unfortunately, not all
devices have a usable built-in TAP controller.

e The IICE can be configured (using the soft JTAG port option) to include a
complete, JTAG-compliant TAP controller. The TAP controller is
connected to external signals by using four standard I/O pins on the
programmable device. Any programmable device family can utilize this
type of cable connection since it only requires four standard I/0O pins.

The following sections provide more detail on these two communication
options.

Using the Built-in JTAG Port

Some programmable device families employ a built-in TAP controller as a
means for device configuration. In most cases, the IICE also can be config-
ured to use this built-in TAP controller. Using this TAP controller saves the
user logic necessary to implement the controller and also saves four I/O pins.

Using the built-in port is slightly more complicated than using the Identify
debug port because the built-in port usually has special board-level connec-
tions that facilitate the programming of the chip. Consequently, these
programming connections must be understood to properly connect the JTAG
cable to the board and to properly communicate with the IICE.
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Boards with Direct JTAG Connections

Boards that connect the built-in JTAG port directly to four header pins on the
board allow the JTAG cable to simply be connected directly to the header
pins. This configuration works for both directly connected devices and
serially chained devices.

A common serial configuration is the combination of an EEPROM with a
programmable device. This configuration allows you to either directly
program the chip, or to program the EEPROM and then use the contents of
the EEPROM to program the device via some other connection (see following

figure).

:lllIlllIlllllllIllIllllIllIllllIllI:
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Cable ™ Ea
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ENN B I =

= Control =

EllIllllIIIIIIIIIIIIIIIIIIIIIIIIIIIIE

This configuration is well suited to the Identify debugger and works just like
any other serially connected chain.

Similarly, when using the Identify tool set in a multi-FPGA environment, the
design is distributed among the FPGAs and the instrumented logic is
included in one or more of the FPGAs. In this configuration, the IICE unit or
units in each FPGA are individually accessed to provide the required debug-
ging capabilities for their associated portion of the design logic.
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Using the Synopsys Debug Port

By configuring the IICE using the soft JTAG port option, the design instrumen-
tation includes a complete, JTAG-compliant TAP controller. The Identify
debugger connects the TAP controller to four top-level I/O connections to the
design. The signal names for these connections are:

» identify_jtag_tck: the asynchronous clock signal

» identify_jtag_tms: the control signal

* identify_jtag_tdi: the serial data IN signal

e identify_jtag_tdo: the serial data OUT signal

Direct JTAG Connection

Commonly, the host computer is directly connected to the four JTAG signals
on the programmable chip as follows:

e The four JTAG I/O signals on the programmable chip are connected to a
header on the circuit board that contains the programmable chip.

e A standard JTAG cable is connected to the four pins on the circuit board

header.

* The other end of the JTAG cable is connected to the host computer.
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Serial JTAG Connection

A programmable chip using the Synopsys FPGA Debug Port can also be
connected in a serial chain. To allow the Identify debugger to communicate
with the device, the configuration of the device chain must be successfully
auto-detected or declared using the chain command (see the Reference
Manual). The steps for making a serial cable connection are the same as a
direct cable connection described above.

JTAG Clock Considerations

The JTAG clock signal syn_tck on the Identify JTAG port drives many flip-flops
in the instrumentation logic — the number depends on the instrumentation,
but can be larger than 1000 flip-flops. Consequently, the clock signal on the
programmable device must be able to drive large numbers of flip-flops and
have low-skew properties. If the JTAG clock signal is not handled correctly, it
is likely that the instrumentation will act erratically.

Most programmable devices have the ability to route such high-fanout
signals using dedicated clock drivers and global clock distribution networks.
Different devices use different methods of accomplishing this and have
different names for this resource. Here are some simple guides:

¢ Some programmable devices have a number of dedicated clock I/O pins
that drive internal clock distribution networks. In this case, be sure to
connect the syn_tck signal to the chip using one of these clock I/O pins.

¢ Other programmable devices have clock buffers and clock distribution
networks that can use any internal signal as a clock signal. For these
technologies, the synthesis tool usually detects high-fanout signals and
implements them with a clock buffer. In this case, it is important to
make sure that the synthesis tool has worked correctly. If it does not put
the syn_tck signal into a global buffer, it may be necessary to manually
add a global buffer to this signal.

Boards Without Direct Built-in JTAG Connections

Some boards are designed so that the built-in JTAG port cannot be reached
from pins on the board. For example, a board may connect an EEPROM
directly to the built-in JTAG port on the programmable device. The EEPROM
is directly programmable from the JTAG connection (see following figure).
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In this case, the only connection that allows the Identify debugger to commu-
nicate with the programmable device is a soft JTAG Port. This configuration
requires a second JTAG cable to directly connect to the four I/O pins on the
programmable device as shown in the figure below.
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Setting the JTAG Chain

JTAG connections on an FPGA board usually chain devices together to form a
serial chain of devices. This chain includes PROMs and other FPGA devices
present on the board.

The Identify debugger automatically detects the JTAG chain at the beginning
of the debug session. You can review the JTAG chain settings by clicking the
Show JTAG chain button in the Communications settings section of the project
window.

Debug: Device ID: IR Length: =]
[] prom 8
[x] fpga 10

o

Auto-detect

To enable the Identify debugger to properly communicate with the target
device, the device chain must be configured correctly. If, for some reason, the
JTAG chain cannot be successfully configured, you must manually specify
the chain through a series of chain instructions entered in the console
window.

Configuring a device chain is very similar to the steps required to program the
device with a JTAG programmer.

For the Identify debugger, the devices in the chain must be known and speci-
fied. The following information is required to configure the device chain:

¢ the number of devices in the JTAG chain

¢ the length of the JTAG instruction register for each device

Instruction register length information is usually available in the bsd file for
the particular device. Specifically, it is the Instruction_length attribute listed in
the bsd file.
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For the board used in developing this documentation, the following sequence
of commands was used to specify a chain consisting of a PROM followed by
the FPGA. The instruction length of the PROM is 8 while the instruction
length of the FPGA is 5. Note that the chain select command identifies the
instrumented device to the system. Identifying the instrumented device is
essential when a board includes multiple FPGAs.

Note: The names PROM and FPGA have no meaning to the Identify
debugger — they simply are used for convenience. The two devices
could be named devicel and device2, and the debugger would
function exactly the same.

Again, the sequence of chain commands is specific to the JTAG chain on your
board; these commands are the chain commands for the board used to
develop this document — the board you use will most likely be different.

Type the following sequence in the console window of the Identify debugger:

chain clear
chain add prom 8
chain add fpga 5
chain select fpga
chain info

The following figure shows the results of the above command sequence.

[ »DESIGHS-IDENTIFY: chain clear

D »DESIGHS-IDENTIFYS chain add prom 8

IHFQ: Added dewice 'prom’ to jtag scan chain.
D sDESIGHS-IDENTIFYS chain add fpga &

IHFQ: Added device 'fpga’ to jtag scan chain.
D sDESIGHS-IDENTIFYS chain select fpga

INFO: How debugging 'fpga'.

[ #DESIGHS-IDENTIFYS chain info

Debug: Dewvice ID: IF Length:
1. [ 1] prom g
2 [=] fpga 5

D:~-DESIGHS-IDENTIFYS
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JTAG Communication Debugging

The Identify debugger performs a number of diagnostic communication tests.
The first time the Identify debugger connects to the on-chip TAP controller, it
performs extensive communication tests. Later, every time the “run” function
is executed, either by clicking the Run button or executing the run command,
simpler and faster tests are executed.

Below is a list of communication related error messages with some additional
explanations.

Basic Communication Test

This test sends a pattern of ones and zeros to the chip and examines the
return values.

* ERROR: Communication is stuck at zero. Please check the cable connection.
It is likely that the Identify debugger is unable to communicate with the
instrumented chip. This error is usually a cable connection problem, or
the cable type is not set correctly.

* ERROR: Communication is stuck at one. Please check the cable connection.
This has the same reasons as a stuck-at-zero communication error.

* ERROR: Communication is returning incorrect IR data. Please check the cable
connection.
If this error is received, then the previous two errors were NOT received
as the communication is returning a mixture of ones and zeroes.
However, the data is not coherent and again the communication connec-
tion is suspect.

¢ ERROR: Communication problem - data sent is not the same as data received.
This test verifies that the Identify debugger can shift data into the
instrumented chip and receive the same data back. If this error occurs,
there is again a problem with your cable connection or the cable type
setting is incorrect.

The last two errors can also be the result of a syn_tck signal that is not using a
high-fanout clock buffer resource, and thus may show large clock skew
properties. If you are using a parallel port, make sure that you have selected
the correct port.
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On-chip Identification Register

The Identify instrumentor adds hardware to implement an on-chip identifica-
tion register.

ERROR: Cannot find valid instrumented design.

The Identify debugger cannot verify that the identification register on the
instrumented design is correct or even exists. This error usually means
that the design on the programmable chip is NOT the instrumented
version of the design.

ERROR: Instrumented design on FPGA differs from design loaded into Identify
Debugger.

The Identify debugger verified that the chip is instrumented but the
instrumentation does not match the project that was loaded into the
Identify debugger.

JTAG Chain Tests

The Identify debugger attempts to verify the device chain (as defined by the
chain auto-detector or the chain command).

ERROR: No hardware devices were found. Please check the cable connection.
No devices can be seen in the JTAG identification register chain.
Probably a bad cable connection, or the cable type is incorrect.

ERROR: The actual number of devices differs from the defined number: ACTUAL: XX
DEFINED: YY

The number of devices seen in the JTAG chain is XX, but the Identify
debugger was expecting the number to be YY (as was defined using the
chain command). The chain description is incorrect.

ERROR: The actual IR chain size differs from the defined size: ACTUAL: XX
DEFINED: YY

The total number of JTAG identification register bits is incorrect. The
Identify debugger measured the hardware to have XX bits, but was
expecting YY bits (as was defined using the chain command). Please
review your chain configuration.
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¢ ERROR: Communication with device number XX is not correct. Please check your
chain setup.
If this error appears, the previous error does not appear. Thus, the total
JTAG instruction register length is correct, but the size of the instruc-
tion register of device number XX is incorrect. It is likely that the order
of your devices is incorrect. Review your chain settings.
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